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Definitions, Acronyms and Abbreviations: 

Name Description

AR Antigen Retrieval

DAB 3, 3’ Diaminobenzidine 

DePar Deparaffinization (also called Dewaxing).

DI Water Deionized Water

FFPE Formalin Fixed Paraffin Embedded

HIER Heat Induced Epitope Retrieval

HRP Horseradish Peroxidase

IHC Immunohistochemistry

IF Immunofluorescence 

L Liters

LED Light Emitting Diode

mL Milliliter

mm Millimeter

Probe dispense range The minimum and maximum reagent volume that can be dispensed by an instrument.

PPE Personal Protective Equipment

Pollution degree
Pollution degree measures how much conductivity is in the air including dry pollution and condensation 

which determines how close to each other conductive parts can be in the instrument. 

RT Room Temperature (20°C-25°C)

µL Microliters

UE Unhandled Exception
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Chapter 1: Introduction
Intended Use

This manual is intended for use by clinical, research, industry and reference laboratory personnel who use the VALENT Automated Staining 

Platform to perform immunohistochemistry (IHC) staining.  This manual describes how to operate the VALENT using the VALENT Software 

and will assume users have been trained and have a basic understanding of IHC procedures. 

About the VALENT Automated Staining Platform

The VALENT is Biocare Medical’s highest-capacity, fully-automated, open-architecture slide stainer designed to perform high-quality 

and consistent IHC staining in lieu of manual staining methods without the variability. However, the VALENT retains the ability to 

integrate established manual staining protocols with an automated platform for ease of use with minimal optimization. The VALENT 

incorporates on-board deparaffinization and heat-induced antigen retrieval, while expanding capacity to 48 slides and shortening turn-

around-time compared with other auto-stainers. 

Limitation of Use

The optimum antibody dilution and protocol for a specific application can vary due to different factors. These may include, but are 

not limited to: tissue fixation, antigen retrieval method, incubation times, tissue section thickness and detection kit used. Due to the 

superior sensitivity of Biocare Medical’s reagents, the recommended incubation times and titers listed in product data sheets are not 

applicable to other detection systems as results may vary and will have to be optimized by the user. The datasheet recommendations 

and protocols are based on exclusive use of Biocare Medical products. Ultimately, it is the responsibility of the investigator to determine 

optimal staining protocol conditions. The clinical interpretation of any positive or negative staining should be evaluated within the 

context of clinical presentation, morphology and other histopathological criteria by a qualified pathologist. The clinical interpretation 

of any positive or negative staining should be complemented by morphological studies using proper positive and negative internal and 

external controls as well as other diagnostic tests.

VALENT Specifications

Catalog Number VLT8101

Slide capacity 48

Independent slide trays 4 trays, 12 slides per tray

Refrigerated reagent & mixing vial rack
44 positions, 20mL vials;

Temperature range: room temperature to 10°C below room temperature

Antigen retrieval temperature range Room temperature to 98°C at sea level

Reagent dispensing volume 300μL

Probe dispense capacity 300μL -14.4mL (48 slides x 300μL/slide)

DePar dispense volume per slide 1mL

Bulk reagent carboys 4 

Waste carboys 2

Waste separation Separates hazardous and non-hazardous

Unit control One instrument per computer

Electrical requirements

Power input: 1800W (1800VA) / Power source: 100-120 VAC, 50/60Hz

The VALENT cannot be used without the VALENT Cart. Power supplied to the VALENT 
from the VALENT Cart may reach 3600W@ 120V.

The use of a dedicated circuit capable of delivering a minimum of 1850W continuously 
with less than 5% voltage sag is required for the instrument. 

Instrument dimensions 40”W X 24”D X 26”H / 102cm W X 61cm D X 66cm H

Instrument weight 245lbs / 111.1 kg
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VALENT Cart Specifications 
Catalog Number VLT8102 (50Hz), VLT8103 (60Hz)

Bulk reagent carboys Six carboys, 8L capacity per carboy.

Secondary containment capacity 11L maximum capacity

Electrical requirements

Power output: 3600W(3600VA)

Power source: 100-120 VAC 50/60 Hz

Requires a step-down transformer rated for 2kW for operation using 220V mains (not 
supplied). Cart must be factory-configured for 50Hz operation.

Do not plug anything into the VALENT Cart besides the computer and label printers.

VALENT Cart dimensions 40”W X 24”D X 30”H / 102cm W X 61cm D X 77cm H

Cart weight 250lbs / 113.4 kg

Undervoltage and 

overvoltage protection

The VALENT Cart is protected from undervoltage/overvoltage conditions by internal relays 

built into the inverter/charger which will limit input voltage to 85-140VAC. Operation is 

prevented if input voltage is outside the specified range.

NOTE: All cart circuit breakers must be in the OFF (down) position before disconnecting 
the power cord from the cart or the wall outlet. Failure to do so may cause the batteries 
to run down and necessitate a service call.

Reagent Vial Label and Slide Label Printers

The VALENT Software is compatible with Microsoft Windows 10 and will have all computer system software pre-installed. The system 

also includes two TSC TC310 Thermal Transfer Printers. One printer is required for slide labels and the second printer is required for 

reagent vial labels.

Report Printer

Please see manufacturer’s specifications.

USB Flash Drive

The VALENT Software allows for the transfer of data to a USB external drive.

Warranty

The VALENT warranty is for one year from date of installation and covers all parts and labor when service is performed solely by Biocare 

Medical Field Services Personnel. The warranty is invalidated if equipment is abused, damaged, misused, or improperly maintained by 

the customer, as determined by Biocare Medical at its sole discretion.  The warranty is not transferable to any other party, should the 

equipment be resold or transferred by the customer to another party. To the extent permitted by law, Biocare Medical disclaims any 

liability for any incidental or consequential damages related to this equipment or for any warranty related services it performs.
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VALENT Components
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1. System Lid

2. Window

3. Slide Trays
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1. Z-head

2. Probe Wash Station

3. Dispense Manifold

4. Reagent Rack

5. Val DePar (Side)

6. Syringe Pump

7. System Lid

8. Fans (8 Total)

9. Troughs (Below Slide Tray)

10. Slide Trays (4 Total)

11. Service Panel
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Z-Head Schematic

5

6

1

3

6

4

5

2

4

3
2

1

5

1

2

3

4

5
6

7

8

9

10

11

1

2

3

4

A probe schematic which includes a separate probe for Val DePar, reagent and Wash-Blow-Wash.

1. Liquid Level Sensor 

2. Barcode Camera 

3. Wash-Blow-Wash

4. Val DePar Probe

5. Reagent Probe

VALENT Cart Components
Carboy Connections

AR
 HI pH

AQ

UA RINSE

AR
 LO pH

C
A

R

BOY SENSO
R

W
AS

H BUFFER

WASTE

H
A

ZA
RDOUS W

AS
T
E

RMIPH50081 REV A

Image of carboy connection panel.
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Carboy Connections

AR HI pH (White) 

AR LO pH (Red) 

AQUA RINSE (Yellow)

WASH BUFFER (Blue)

HAZARDOUS WASTE (Black)

WASTE (Teal)

Image of a carboy and carboy sensor cables

5

6

1

3

6

4

5

2

4

3
2

1

5

1

2

3

4

5
6

7

8

9

10

11

1

2

3

4

Side view of the VALENT Cart displaying electrical connections.

1. Carboys

2. Secondary Containment

3. Instrument Power Circuit Breaker

4. Cart Power Circuit Breaker

5. Battery Circuit Breaker

6. Air Vents

NOTE: All cart circuit breakers must be in the OFF (down) position before disconnecting the power cord from the cart or the wall outlet. 
Failure to do so may cause the batteries to run down and necessitate a service call.
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VALENT Description of Parts 

Parts Description

Independent slide trays

The VALENT includes four removable stainless steel slide trays, each with a 12-slide 

capacity. The slide trays secure the slides firmly in a horizontal position at all times 

during the staining run. The slide trays can be removed from the instrument for loading 

slides, and then reinserted, without opening the system lid. 

There is an LED sensor which, when RED, indicates the slide tray is locked in place 

and may not be removed. When the LED turns green, the slide tray may be removed or 

reinserted. The LED is off when a slide tray is removed from the instrument.

System lid

The VALENT system lid operates with a gas strut motion control system which allows 

access to the work surface. The system lid automatically locks at the start of a run. The 

lid must be closed during the operation of the instrument. The system lid status can be 

viewed from the VALENT Software Home Screen or by the LED light (red if locked, green 

if unlocked).

Syringe pump
The syringe pump is a positive displacement pump used for aspiration and dispensing of 

reagents on slides, for mixing reagent components and probe washing.

Fans

The internal fans are designed to reduce humidity and temperature during heated 

antigen retrieval. There are a total of 8 fans in the upper chassis, 4 intake fans are 

located on the VALENT system lid and 4 exhaust fans are located on the back panel 

of the VALENT.  The fans operate in different combinations and automatically turn 

on and off during AR. In addition, there are five fans in the lower chassis to cool the 

componentry following AR.

Reagent rack

The reagent rack is a stainless steel rack with 44 vial positions for 20mL VALENT vials, 

this rack can slide in and out of the instrument without opening the system lid. The 

reagent rack is cooled throughout the run keeping reagents below room temperature. 

Each reagent rack is calibrated to a specific instrument and can’t be substituted for 

another reagent rack.

Reagent vials

All vials have a 20mL capacity with a screw cap and a 50μL dead volume. Vials can 

be filled with the volume specified by the selected protocol or with excess volume in 

preparation for use in a subsequent run.  

The VALENT will mix designated reagents in empty 20mL VALENT vials when online 

mixing is selected. Do not re-use mixing vials; always use new, clean mixing vials to 

prevent contamination and/or staining artifacts. The VALENT Software automatically 

calculates a 50μL dead volume for all mixing vial reagents.
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Z-head

The Z-head, (see Figure 1c), is mounted on the Y-arm that moves along the horizontal 
left/right X-axis inside the instrument. The following are components of the Z-head:

Reagent Probe: The instrument uses a Teflon coated stainless steel probe. The probe is 
washed inside and out before each new reagent is applied. The reagent probe employs a 
high-accuracy dispense mechanism which gently dispenses reagents across a slide in a 
manner that avoids any tissue disruption. 

Liquid Level Sensor: The ultrasonic level sensor detects the reagent volume level. The 
system will provide a visual alarm if there is insufficient reagent to complete the run. 
The run will not start if reagent volumes are insufficient for the programmed protocols.

Barcode camera: The barcode camera, is used for scanning slide and reagent barcodes 
and is capable of Optical Character Recognition (OCR) and image recognition. The 
barcode camera ensures that the correct vials and slides are in place to prevent errors. 
Additionally, the barcode camera  allows the software to alert the user if reagent vial 
caps are still mistakenly left in place before a run starts. 

Wash-Blow-Wash Nozzle: In a single pass, the nozzle applies a layer of Aqua Rinse or 
Wash Buffer, followed immediately by a curtain of air to blow off the wash, and then a 
second layer of Aqua Rinse or Wash Buffer to wash a second time. This occurs at each 
rinse step and also at preset intervals to keep slides from drying out during the holding 
time before the start of a run. The air nozzle removes excess liquid from a slide before 
applying reagents by blowing air across the entire width of the slide.

Probe wash station
The probe wash station is located next to the Z-head park position and is used to wash 

the reagent probe. The reagent probe is cleaned in the wash station throughout a run.

Bulk reagents and carboys: Antigen 

Retrieval (AR), Aqua Rinse and Wash 

Buffer

AR-Hi pH, AR-Lo pH, Wash Buffer and Aqua Rinse Carboy assemblies have liquid level 

sensors to detect volume levels. The carboys allow for a nominal volume of 8L with 

1L of dead volume. If there is insufficient Wash Buffer or Aqua Rinse in the carboy 

assemblies, the instrument will not initiate the staining process. 

Check the levels of the bulk reagents before each run, replenish and reset if indicated 

by the VALENT Software during the staining process. The required volumes for each run 

are calculated by the VALENT Software and displayed during the programming process. 

Bulk mixing carboys

10L bulk mixing carboys are used for preparing bulk reagents which include Wash 

Buffer, Aqua Rinse and Antigen Retrieval. Bulk reagents prepared in these bulk mixing 

carboys will be transferred to the 8L bulk reagent carboys on the VALENT Cart.

Waste storage

The VALENT separates hazardous and non-hazardous waste. A non-hazardous waste 8L 

carboy and a hazardous waste 8L carboy are provided for accumulated waste collection. 

The actual amount of waste volume generated will depend on the number of slides 

programmed per run and staining protocol. The required available volumes for each run 

are calculated by the VALENT Software and displayed during the programming process. 

Both waste carboy volumes should be checked and emptied as needed before starting a 

staining run. 

Dispense Manifold There is a dispense manifold for each trough that dispenses AR and Aqua Rinse onto the slide.

Troughs
There are four troughs on the VALENT, located below the slide trays, that are used for 

the antigen retrieval step and draining reagents to waste.

DePar
A mineral oil based deparaffinization reagent is held in a 500mL bottle located to on the 

left side of the VALENT.

Window The VALENT has a red window to prevent photobleaching of fluorochromes.
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Storage and Handling 
Reagents

Always follow manufacturers’ instructions for storage and handling of reagents. To prevent contamination, follow good laboratory 

practices of sterile technique when opening, diluting, and decanting all solutions. When not in use, store Biocare Medical reagents at 

the recommended storage conditions as specified in the data sheets to maintain reagent stability.

Instrument Environmental Conditions

Placement Indoors, away from direct sunlight and extreme heat or cold.

Operating temperature range 15-30°C (59-86°F); Recommended: 20-24°C (68-75°F) for optimal staining results.

Storage temperature range 10-40°C (50-104°F)

Transport temperature range 0-50°C (32-122°F)

Maximum relative humidity 80%, non-condensing 

Humidity Maximum relative humidity 80%, non-condensing

Ventilation
Do not block the vent openings on the VALENT.

Leave a minimum of 2 inches of space between the instrument and the wall, cabinets or 

other obstructions.

Venting (exhaust)
The instrument does not need special exhaust ventilation, unless required by safety 

regulations when using reagents not specified by Biocare Medical.

Recommended maximum altitude

6562 feet

Lower boiling temperature and a higher evaporation rate must be considered for labs in 

a higher elevation. For example, if the optimal temperature for antigen retrieval is 98°C 

with an elevation below 1500 feet, the antigen retrieval temperature may have to be 

optimized if the elevation is above 3750 feet. 

Pollution degree 2
Normally only nonconductive pollution occurs. Temporary conductivity caused by 

condensation is to be expected.

Positioning the VALENT 

The right side of the instrument and VALENT Cart must be positioned at a minimum of 8 

inches from any wall or other obstruction to allow access to all power switches and cables. 

There must also be adequate clearance to allow disconnecting of the cart power cable 

from the main wall receptacle.

Main supply voltage fluctuations ±5%

Overvoltage category Category II

Specification of heat transfer media 

suitable for use

All heat transfer media are water-based reagents with high or low pH buffer salts and a 

mineral oil based DePar reagent. No other media is allowed during heat cycle.
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Humidity

During Antigen Retrieval humidity levels may increase and create condensation, to prevent this the lab should have an operational HVAC system. 

Avoid humidity extremes. Low humidity can cause electrostatic problems that may affect the computer. High humidity may create 

excessive condensation.

Waste Disposal 

Some of the reagents used on the VALENT may be hazardous, and must be disposed of properly in accordance with local regulations. 
The lab should determine from the Safety Data Sheets (SDS) for a given reagent whether the reagent is hazardous. The VALENT can be 
programmed to separate waste streams for chromogens considered  to be hazardous. The carboy used for this waste stream is marked 
“Hazardous Waste.” This carboy must only be used solely for hazardous waste in order to avoid unnecessarily increasing the volume of 
any hazardous waste. 

In the event a spill of hazardous materials occurs inside the instrument, unplug instrument from the cart and unplug the VALENT Cart 
from the wall outlet. NOTE: All cart circuit breakers must be in the OFF (down) position before disconnecting the power cord from 
the cart or the wall outlet. Failure to do so may cause the batteries to run down and necessitate a service call. The user is required to 
use PPE which may include a lab coat, gloves, and safety glasses. Use disposable absorbent material to soak up small spills. Follow 
approved lab procedures for handling larger spills. Refer to appropriate Safety Data Sheets for proper handling of reagents. The VALENT 
Cart has built-in secondary containment for bulk reagent spills with a 11L maximum capacity. If spills occur inside the instrument 
contact Biocare Medical’s Technical Support before reconnecting the power. 

Instrument Disposal

If the VALENT is to be removed from service and disposed of, the instrument must be disinfected using Lysol IC Quaternary Disinfectant 

Cleaner through the fluid delivery and waste systems. Similarly, all exposed surfaces must be disinfected using 10% Professional Lysol IC 

Quaternary Disinfectant Cleaner before it is disposed of in accordance with local, state and federal regulations.

The VALENT Cart batteries should be re-cycled or properly disposed of in accordance with local regulations.

Site Installation Requirements

Performance checks are conducted by the manufacturer prior to shipping. Biocare Medical Field Service Personnel will unpack or 

supervise the unpacking, of the VALENT. Biocare Medical Field Service Personnel will verify the system performance to determine 

any deficiencies in operation as a result of shipping and will rectify any problems with regard to performance or components. Biocare 

Medical Field Service Personnel will also provide basic operating instructions.

Note: The VALENT weighs approximately 245lbs and must be handled from the bottom of each side of the chassis by two people or 

more who are safely capable of lifting the specified weight. Do not lift the instrument from the system lid, doing so will cause damage 

to the VALENT and void the warranty.

If the VALENT is placed on a laboratory bench, the bench must be solid, vibration-free with a flat area, capable of safely supporting the 

weight of the instrument. Additional consideration must be made for a minimum clearance of 2 inches on all sides for ventilation and 

room for an all in one computer, keyboard and mouse next to the instrument. The label and report printers for the VALENT may be located 

anywhere that allows them to be connected to the instrument. Biocare Medical will provide a cart for the computer and printers. Nothing 

may be placed on top of the VALENT.

The use of a dedicated circuit capable of supplying a minimum of 1850W continuously is required for proper operation. Do not connect 

the cart to the same circuit as other equipment, lighting, or any other electrically operated devices.

Support

To contact Biocare Medical Technical Support by telephone, please call 1-800-799-9499, Option 3 or email Technical Support at 

techsupport@biocare.net.
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Chapter 2: Safety Precautions
Recommended Use

The VALENT is designed for use with FFPE tissue samples. Fresh (unfixed) tissue may contain infectious organisms, infectious sample 

use is limited to tissues/specimens that are specified in Biocare Medical’s product data sheets. Handle control slides and test FFPE 

slides as if capable of transmitting infectious agents, and dispose with proper precautions. It is recommended that the specimens are 

handled using established good laboratory working practices.

Reagents and Chemicals

Some of the reagents and chemicals recommended by Biocare Medical for use on the VALENT are classified as hazardous. These 

must always be used according to the manufacturer’s instructions and good laboratory practices. Always wear PPE such as gloves, 

eye protection and a protective lab coat when handling any chemical solution used on the VALENT, and when cleaning the VALENT 

or emptying waste carboys. Obtain a Safety Datasheet (SDS) from the manufacturer for each reagent. Do not use any chemicals on 

the VALENT other than those specified. Biocare Medical offers Val Clean, an acid alcohol-based cleaning solution for the removal of 

hematoxylin residue. Danger from hazardous fumes, fire or explosion may result with the possibility of injury to the operator or damage 

to the instrument.

It is the user's responsibility not to use decontamination or cleaning agents, other than specified in this manual. Contact Biocare 

Medical Technical Support before using unspecified cleaning agents.

Reagent Rack

Always use both hands when loading and unloading the reagent rack. Using both hands, one hand holding reagent rack from the front 

and the other hand from the bottom, load the reagent rack with filled reagent vials in the correct orientation; the reagent rack handle 

should be towards the front of instrument, facing the user. Reagent vials must  have the label positioned toward the front of the VALENT, 

facing the user. When unloading a reagent rack once a run is complete, the bottom of the reagent rack may be cold, use a paper towel 

or other absorbent material to hold the reagent rack from the bottom. Tipping of the reagent rack may result in injury if the rack is not 

securely placed in its designated position, or handled securely during transport.

Instrument Safety Guidelines

1. Use only the authorized VALENT Software program that is supplied with the instrument, or authorized software updates.

2
Do not install any other software applications onto the VALENT’s dedicated computer system. This may cause an unexpected 

operation of the VALENT or corrupt the operating software and will void the instrument warranty.

3. Do not switch off power to the computer until the VALENT Software is properly closed.

4. Do not turn off power to the VALENT until all motion has stopped and the robotic arm is in the home position.

5. The system lid of the VALENT must be closed before operation will begin.

6. Do not attempt to remove reagent rack or slide trays while the system lid is locked during a run.

7. Keep carboy assemblies below the level of the VALENT.

8.
Proper cleaning is important for the reliable operation of the VALENT. Follow the recommended cleaning procedures in 

Chapter 7.

9.
The robotic arm must be stopped before the VALENT’s system lid can be opened. The status of the system lid can be viewed 

from the VALENT Software Home Screen.

10. Do not place your hands, fingers or other body parts underneath the VALENT, this may cause injury.

Programming Cautions

To help prevent false positive or false negative results ensure all staining protocols are programmed correctly. If unexpected results 

occur, check the programming first. The VALENT provides the option to enter patient information for each slide. Make sure to enter the 

correct patient identifier information for each slide. 
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Lithium Battery

This device contains one or more Lithium Iron Magnesium Phosphate Batteries. The batteries should not be opened or burned. The 

batteries are safe with normal use. Exposure to the ingredients contained within and or their combustion products could be harmful. 

Risk of exposure occurs only if the battery is mechanically, thermally, or electrically abused to the point of compromising the battery 

enclosure. If the battery enclosure is compromised, exposure to the electrolyte solution contained within can occur by inhalation, 

ingestion, eye contact and skin contact.  More information is available from the manufacture of the battery, LithiumWerks.

Safely Turning on the Cart

If the VALENT Cart has to be switched on or off, the instrument must be switched on or off in a specific order to avoid system failure. 

Instances where the instrument cart may need to be turned on or off include:

• When moving the instrument to a different location.

• If there has been a power outage and the instrument requires proper shut down.

• When the user does not plan to use the instrument for at least two weeks or longer a week or more.

• If the VALENT Software and/or printers are not functioning appropriately.

Turn ON the Cart

TO INSTRUMENT

CART BATTERY

Turn cart battery OFF

when cart power is off or 

cart is unplugged.

CART POWER

COMPUTER

INSTRUMENT
POWER

Power: 1,800 VA
115 VAC  100/120 VAC
Model VLT8102: 50 Hz
Model VLT8103: 60 Hz
Circuit Breaker: ISA Resettable

WARNING

1. Turn On the Cart Power Circuit Breaker

2. Turn On the Cart Battery Circuit Breaker

3. Turn On the Instrument Power Switch Circuit Breaker

1

23

• Confirm that all circuit breakers on the side of the cart are in the OFF (down) position, (refer to the diagram above.)

• Confirm that the cart is plugged into a dedicated electrical outlet capable of supply at least 1850W continuously.

• Confirm that the 30A instrument power umbilical from the cart is connected to the receptacle on the right side of the instrument.

• Confirm that the battery sense cable from the cart is connected to the receptacle on the right side of the instrument.

• Turn on the cart power circuit breaker, which is the white switch located on the electrical panel on the right side of the cart. 

• Wait 60 seconds for the battery charger to sense wall power.

• Turn on the cart battery circuit breaker, which is the black switch located on the right side of the panel.

• Immediately after the cart battery circuit breaker is turned on, the battery charger fan inside the cart will be audible for approximately 

5 seconds, indicating the charger has turned on.

• If the charger does not turn on, toggle the cart battery circuit breaker off and then back on again until the charger turns on.

• Turn on the instrument power switch circuit breaker, which is the black switch located to left of on the left side of the panel.

• Turn on the instrument using the large white power switch on the right side of the instrument.

• Turn on the computer.
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Turn OFF the instrument

Turning off the instrument is the reverse order as turning on instrument:

• Exit out of software, then turn off the cumputer.

• Turn off the instrument using the large white power switch on the right side of the instrument.

• Turn off the instrument power circuit breaker which is the black switch located on the left side of the cart panel.

• Turn off the cart battery circuit breaker which is the black switch, located on the right side of the panel.

• Turn off the cart power circuit breaker, which is the white switch on the cart panel.

NOTE: All cart circuit breakers must be in the OFF (down) position before disconnecting the power cord from the cart or the wall outlet. 
Failure to do so may cause the batteries to run down and necessitate a service call.
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Symbols Glossary

The following symbols may appear on the instrument label:

Warning. Biohazardous materials may be present. Personal 

protection is required.

Attention. Des matières biologiques dangereuses peuvent 

être présentes. Une protection individuelle est requise.

Warning. Electrical shock hazard. Attention. Risque de choc électrique.

CE Marking Marquage CE

In-Vitro Diagnostic Medical Device Dispositif médical de diagnostic in vitro

Manufacturer Fabricant

Serial number Numéro de série

 
Consult instructions for use (consult operating instruction).

Consultez les instructions d'utilisation (consultez le mode 

d’emploi).

Electrical Earth Ground Terre électrique

Main Power (ON/OFF) Interrupteur Principal (ON / OFF)

Caution. Surface may be hot. Attention. La surface peut être chaude.

Warning. Pinch Point. Keep hands and fingers clear.
Attention. Risque de pincement. Gardez les mains et les 

doigts éloignés.

Caution, consult accompanying documents. Attention. Reportez-vous au manuel de l'utilisateur.

On (Power) Allumer

Off (Power) Éteindre

Identification of Authorized Representative in the European 

Community.

Identification du représentant autorisé dans la 

Communauté européenne

Caution, 3 kg, potential heavy equipment. Attention, 3 kg, équipement lourd potentiel.

Heavy object. Objet lourd.
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Chapter 3: VALENT Software Features & Functions 
This chapter is intended to familiarize the user with the VALENT Software’s key features, providing details of all operation modules 

available to administrators and regular users.

User Access

There are two levels of access for users of the VALENT Software: regular user and administrator. Users with administrator privileges 

have access to all screens available to regular users, but have some additional privileges that will be discussed in this chapter. Screens 

used by both users are described in this chapter. The VALENT Software can only have one administrator with an ‘Admin’ user id but 

there can be many administrator level users.

Login

To log in, double-click the VALENT icon on the desktop, enter the User ID and Password in the dialog box, select Language, and click 

Login to continue.

Note: Default User ID is admin, default password is valent.

Home Screen

1. Menu Bar 2. Run Designation Buttons 3. Run End Time 4. Reagent Rack 5. System Lid Status 6. Reagent Rack Lock/Unlock Status 

7. Reagent Rack Temperature 8. Carboy Status 9. Slide Tray Position 10. Slide Tray Lock/Unlock Status 11. Slide Tray Status
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Home Screen Features

Name Function

1. Menu Bar Select from the menu bar to navigate instrumental functions and access information.

2. Run Designation Buttons Allows user to Prepare Slides, Map Slides, Print Reports or Cancel Run.

3. Run End Time Displays the run end time.

4. Reagent Rack 

The reagent rack is a stainless steel rack with 44 positions for 20mL vials that can easily slide 

in and out of the instrument. The reagent rack remains below room temperature throughout a 

run. Use the mouse cursor to hover over a reagent vial to view reagent information during a run.

5. System Lid Displays whether system lid is opened or closed.

6.
Reagent Rack Lock/Unlock 

Status
Displays whether the reagent rack is locked or unlocked.

7. Reagent Rack Temperature
Displays the temperature of the reagent rack to ensure reagents are stored at an acceptable 

temperature range.

8. Carboy Status

The carboy status indicates if there is sufficient DePar, Aqua Rinse, Antigen Retrieval (AR) 

and Wash Buffer available in the bulk reagent carboys.  The carboy status also displays the 

amount of non-hazardous waste and hazardous waste in the carboy.  

A reminder will be displayed when bulk reagent carboys are low and when waste carboys need 

to be emptied.

9. Slide Tray Position

The VALENT Software displays the location of each slide on the slide tray numbered from 

1-12. Hovering over a mapped slide allows the user to view slide information and protocol 

during a run.

10.
Slide Tray Lock/Unlock 

Status
Displays whether a slide tray is locked or unlocked. Slide trays are locked during a run.

11. Slide Tray Status

The VALENT Software displays the slide trays and the slide positions graphically on the user 

interface. The slide trays are designated A-D. Tray status indicates whether the tray is in 

process (red) or available (green). 
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Run Designation Buttons 

Run Designation Buttons on the Home Screen provides access to Prepare Slides, Map Slides, Print Reports and Cancel Run. These 

options allow the user to quickly and seamlessly start a run.

Action Buttons Description

Prepare Slides
This option is the starting point to preparing a run; add, copy, delete or import slides for a run, and select 

or modify protocols.

Map Slides Allow assignment of protocol or prepared slides by manually mapping to a specific tray location.

Print Reports View and print IHC Summary, IHC Report, IHC Short Report and Protocol Validation.

Cancel Run Allows user to abort a run. This button is red when a run is in process.

Menu Bar

The menu bar in the upper left corner of the VALENT application’s main screen and provides access to a number of functions.

Staining Run

Staining Run allows the user to Cancel Run or Close the Application.
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Data Manager

Data Manager allows the user to access reagent lists, inventory, protocols, templates, user accounts, custom groups, and slide information.

Function Description

Reagent Manager Add new reagents, modify existing reagents and print reagent labels. 

Protocol Manager Design, edit and manage protocols.

Template Manager Design, edit and manage detection templates.

User Accounts Create new user accounts and modify existing accounts.

Inventory Manager
Enter and track reagent lot, expiration, starting volume, current volume, and lot number to be used on the 

instrument. 

Custom Groups
Allows the laboratory to create groups of protocols under Group Manage, frequently used by the laboratory 

rather than having to scroll through all the protocols.

Slide Fields Slide Fields allows the user to create, edit and manage data fields that may be associated with a slide.

Slide Map Fields Slide Map Fields is the information that shows up on mapped slides on the Home Screen.  

Import New Products
Upload new Biocare product data to the VALENT software. Please contact your local Biocare Medical 

representative for details on new product availability.
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Tools
Tools allows the user to access the instrument functions listed below.

Function Description

Software Settings
This feature allows the administrator to set preference and default parameters. VALENT Software 

settings can be entered manually or accessible from a dropdown menu. 

Print Reports

Print Reports allows the user to print out Slide Layouts, Reagent Layouts, Run Logs, and Reagent 

Worksheets. The user can also print to PDF.

Several IHC Reports and Protocol Validation can be accessed through the Report Generator.

Clear Unused Reagents
Removes reagent vials from the reagent rack that are no longer needed for the staining run. This 

option is only accessible after a run is complete.

Clear Completed Trays Releases the slide tray from instrument and allows the user to remove the slide trays.

Label Designers Slide and reagent labels can be edited under Label Designers.

Instrument Operations
Allows the user to perform routine maintenance such as: Drain Waste, Prime Buffers, System 

Cleaning, Reset Carboys and Read Sensors.

Configure Reagent Wash Lists
The user can add reagents that require special handling for decontamination to the Configure 

Reagent Wash List to signal a cleaning step to help prevent contamination in the probe. 

Dilution Calculator
Automatically calculates how to dilute a stock solution of known concentration to the required 

working concentration.

Configure AR Carboys
Allows the user to assign an antigen retrieval (AR) solution to the two designated AR Carboys. 

Biocare Medical's antigen retrieval solutions include AR-Lo pH 6.2 and AR-Hi pH 9.5.

Turn Interior Lights On/Off Select this function to turn interior lights on or off.

Turn Refrigerator On
Allows user to turn reagent rack refrigeration on. The refrigerated rack keeps reagents below room 

temperature throughout a run.

Connect to Computer Allows computer and instrument to communicate.
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Print Reports

Use the Print Reports button to view and print the following reports: IHC Summary, IHC Report, IHC Short Report and Protocol Validation.

There are two ways to print reports:

     • The Print Report button is displayed on the left side of the Home Screen.

     • Print Reports can be accessed through the Tools dropdown menu.

           o From Tools select Print Reports then go to Report Generator. Click the desired report parameter then click the Generate Report button.

Report Description

IHC Summary Report
Provides a summary of all the slides that were stained in a run along with the protocol used for 

each slide.

IHC Report Provides a detailed summary of all the slides within a case with the protocol for each slide.

IHC Short Report Provides a brief summary of all the slides within a case with the protocol for each slide. 

Protocol Validation Report
Provides a report for a protocol indicating all the steps, along with the reagents used, a comment 

section, and a sign off section for pathologists.
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Configure Reagent Wash Lists

The Configure Reagent Wash Lists is composed of a Contamination List, PrepWash List and Aqua Rinse Wash List. Adding reagents to 

these lists according to the three conditions explained below will prompt the probe to undergo a ValPrep washing to ensure the probe 

is clean in order to prevent contamination. ValPrep is a cleaning reagent that is required when using Alkaline Phosphatase (AP) labeled 

detection systems and compatible chromogens.

To access Configure Reagent Wash Lists from the Home Screen, go to the menu bar and select Tools, then click Configure Reagent Wash 

Lists and select from Contamination Lists, PrepWash List or Aqua Rinse Wash List.

Contamination List and PrepWash List

The Contamination List and PrepWash List work together to ensure the probe is thoroughly cleaned with ValPrep to wash off AP Polymer 

residue. After it aspirates each reagent that was added to the Contamination List, the probe will immediately wash with ValPrep. 

Use the PrepWash List to add reagents that require the probe to be pre-washed with ValPrep Solution before it aspirates a reagent on 

this list. Reagents that have potential for contamination, typically the buffer used to dilute the chromogen, should be added to the 

PrepWash List.

To activate the ValPrep wash, the three conditions below must be met:

1. The reagent that will cause contamination, any Alkaline Phosphatase (AP) polymer needs to be added to the Contamination List.

2. The mixing component that has the potential for contamination, typically the Alkaline Phosphatase (AP) chromogen buffer used to 

dilute the Alkaline Phosphatase (AP) chromogen needs to be added to the Prep Wash List.

3. Set the end product chromogen in the Reagent Manager to unstable.

Contamination List

To add reagents to the Contamination List, select the reagent to be added from the Reagent List and click the green arrow facing right 

to add to Contamination List. To delete a reagent from the list, select the reagent to be deleted and green arrow facing left.

PrepWash List

To add reagents to the PrepWash List, select the reagent to be added from the Reagent List and click  the green arrow facing right to 

add to the PrepWash List. To delete a reagent from the list, select the reagent to be deleted and click the green arrow facing left.

Aqua Rinse Wash List

The Aqua Rinse Wash List is intended for reagents that may have staining quality affected when exposed to buffer before aspiration. 

When a reagent is added to the Aqua Rinse Wash List, the probe is primed with Aqua Rinse before aspirating the reagent in the Aqua 

Rinse Wash List.

To add reagents to the Aqua Rinse Wash List, go to Tools-> Configure Reagent Wash Lists-> Aqua Rinse Wash List and select the reagent 

to be added from the Reagent List and click the green arrow facing right to add to Aqua Rinse Wash List. To delete a reagent from the 

list, select the reagent to be deleted and click the green arrow facing left.
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View Menu

The View dropdown menu allows access to Notifications, Run Time Estimates, Cleaning Log and Run Log. Notifications is not accessible 

unless there is a notification to view.

Notifications

If a problem occurs during the run, the VALENT Software will display a notification. The Notification Details window will appear with a 

description of the action required and the slide(s) affected. Follow prompts on the screen to clear the notification.

Run Time Estimates

When a staining run is started the run end time is estimated.

Run time estimates can be viewed two ways:

          • Run Time Estimates can be found on the top of the main screen, above the reagent rack display. The time the run is expected to  

           end is displayed. Separate run end times for each slide tray can be found above each slide tray.

       • Run Time Estimates can also be viewed via the menu bar by selecting View and Run Time Estimates. This will display the  

            estimated run end time for each slide and for each slide tray.
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Cleaning Log

The cleaning log displays the date the system was cleaned, how many slides since its last cleaning and the user who performed the 

cleaning. Click Print Log, located at the bottom right of Cleaning Log window for a copy of the Cleaning Log.

 
Run Log

The Run Log documents the time, date, instrument ID & serial number, VALENT Software version, and run name. The Run Log also 

displays all operations performed by the instrument. As an operation is performed, the log is updated.

The Run Log can be viewed during a run or immediately after a run is completed otherwise the Run Log option will be grayed out not 

allowing access until the next VALENT run.  

 

Help 

The Help dropdown menu allows the user to:

      • View the product name and product version. 

      • Access the VALENT User Manual.

      • Provide Technical Support contact information.
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Chapter 4: Program Preparation & Setup 
Administrator Program Preparation & Setup 

Administrators can follow the detailed steps in this chapter to add or change users, passwords, reagents, and protocols.

Summary of Administrator vs. Regular User Profile

Below is a summary of the features that are available for an administrator and a regular user.

Action Buttons Administrator  Regular User

Reagent Manager Add, modify or delete reagents. Add, modify or delete reagents.

Template Manager Add, modify or delete template protocols.
Modify templates only, adding and deleting 

templates is restricted.

Software Settings Set Instrument Parameters, Notifications and Alarms. No Access Allowed.

User Accounts Add, delete or modify accounts including passwords. Change password.

Assign or Modify Users

Only administrators can assign or modify user accounts. Regular users can only modify their passwords.

      • From the Home Screen select Data Manager and click User Accounts. 

      • The User Manager window will appear.

      • To add a new user, press the green Add (+) button at the bottom left side of the screen.
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      • Enter the appropriate user information and click Save (green check mark).

User Information Guideline 

User Information Description

User ID
This must be unique. The system does not require a specific naming convention and is at the discretion of 

the user.

Password
This must be unique. The system does not require a specific naming convention and is at the discretion of 

the user. There is a minimum of 6 characters required and a maximum of 15 characters.

Full Name Enter user’s first and last name. Full Name may be duplicated, but the User ID must remain unique.

Title List end-user title. This is a free form text field.

Access Level Access level is defined to administrator or regular user.

Modify a User Account

To modify an account or password, select the appropriate account and press Delete (X) or Edit (3 gray arrows) button at the bottom left 

side of the screen.
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Modify Passwords

Administrators and regular users may change their password through User Accounts.

      • From the top right side of the Data Manger dropdown menu select User Accounts. 

      • From the User Manager window, select the edit button located at the bottom left (3 gray arrows) button.

      • Update the password information and click Save (green check mark) to proceed. 

      • Click Close to close window.

Software Settings

Software Settings can be accessed from the menu bar under Tools. This feature allows the administrator to set preferences and default 

parameters. Software settings are selected from dropdown menus. There are two parameters listed: System Parameters and Instrument 

Parameters. When the user clicks on a parameter, a description of it will appear at the bottom of the window. 

w
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System Parameters

Under System Parameters, the user can adjust the parameters listed below.

Parameter Description

Slides After Run
Select True or False. If True is selected, slides are air dried after a run. If False is selected, slides will 

not be air dried. 

Buffer Slides After Run
Select True or False. If True is selected, buffer will be applied to slides after the run completes at the 

designated interval. If False is selected, slides will air dry after the run completes.

Select Post Run Buffer Designates either Buffer or Aqua Rinse to be applied if Buffer Slides After Run is set to True. 

Buffer Interval
Time in minutes between buffering of slides after run completion. Valid range is between 15 and 30 

minutes.

Default Vendor Default Vendor is Biocare Medical. This is displayed when creating a new reagent in Reagent Manager.

Default Negative The Val Universal Negative Control is catalog number VLT8015

Instrument Parameters

Instrument parameters should not be modified by the user. Please call Technical Support for assistance.
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Reagent Manager
Reagent Manager is used to add new reagents, modify or delete existing reagents by both regular users and administrators. Reagent 

Manager can be accessed from the menu bar.

Reagent Groups

Reagent Groups, listed on the left side of the screen, are reagent categories including: DePar, Antigen Retrieval, Enzyme, Block, 

Antibody, Negative Serum, Secondary, Tertiary, Chromogen, Counter Stain, Ancillary and Mix. 

DePar

The user is required to use Biocare Medical's DePar and cannot edit this group 

Antigen Retreval 

The user is required to use Biocare Medical's Antigen Retreval Solution and cannot edit this group 

Enzyme 

This group is used to add, modify and delete enzymes.

Block

This group is used to add, modify and delete blocking solutions.

Antibody

The antibody reagent group allows the user to enter new primary antibodies. This selection will allow the addition, modification and 

deletion of antibodies.
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At the bottom of the Reagent Details box:

Designate the appropriate fields that are linked to the primary antibody of interest. For reference purposes, the user has the option to 

indicate the Clone, Species, Diluent and Comments associated with the antibody of interest.

Negative Serum Group

The Negative Serum reagent group is used to assign negative controls associated with antibodies. This screen will allow the addition, 

modification and deletion of negative control reagents.

When a negative control is ordered for a particular antibody, a duplicate protocol will be assigned to the case using the negative serum 

linked to the antibody.

  

Secondary Group

This group is used to add, modify, and delete secondary reagents. 

Tertiary Group

This group is used to add, modify, and delete tertiary reagents. 

Chromogen Group

The Chromogen reagent group is used to add, modify, and delete chromogens. The Chromogen reagent group offers greater detail than 

other reagent groups, and allows the user to program mixing of chromogens online. The user can also specify if a reagent is stable or 

unstable if added under Chromogen Components under the Mix Group.

Counter Stain Group

The Counter Stain reagent group includes all counter stains. This screen will allow the addition, modification, and deletion of 

counterstains. 

Ancillary Group

The Ancillary reagent group includes all ancillary reagents not included in any other Reagent Group options. This screen will allow the 

addition, modification, and deletion of ancillary reagents. The option for mixing ancillary reagents is available in this group if added 

under Ancillary Components under the Mix Group.

Mix Group

The Mix reagent group is used to designate components of chromogens, enzymes, and ancillary reagents which will be used by the 

VALENT to perform on-board mixing of these reagents.

Display Reagent Information

      • Use the search field at the top of the Reagent Manager window to quickly find a reagent under the selected Reagent Group.

     • Highlighting a group in the Reagent Group list will display a list of reagent group members in the upper right of the Reagent  

         Manager screen.

      • Highlighting a reagent in the reagent list will display information about the reagent in the Reagent Details box in the lower right  

         side of the Reagent Manager screen.
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Template Manager
Template Manager allows an administrator to modify or delete templates. Regular users can edit current templates under Template 

Manager but cannot add or delete templates.

Important Note: When creating or editing a protocol from an existing template, click out of the current cell and to a different cell to 

lock in the changes.  

Description of Template Manager Icons

Icon Description Icon Description

Add a new step at the end of a protocol. Move up the selected step in a protocol.

Delete a step at the end of the protocol. Move down the selected step in a protocol.

Insert a new step before the selected step in a 

protocol.

Creating a Template from a Blank Template

      • From the Home Screen, go to Data Manager, then select Template Manager.

      • To the bottom left under Protocols, select Add (+), to add new template.

      • A Create New Template window will appear.



31

      • In the Template Name field, type in the name of the new template.

      • Under Options, select Blank Template.

      • Click Create.

      • Select Add (+) located at the bottom of the window, this opens the Add a New Step window.
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      • Using the dropdown menu Select a Step along with the reagent required for this step, then click Add Step.

      • Continue adding steps to protocol by selecting Add (+) button. Use the icons to create a template.

     • Once all steps are added, the user can program time, select reagents from a dropdown menu, (to add reagents go to Reagent 

Manager). The user can select the number of washes required in each step under Count. Blow can be switched on or off by 

selecting the red (X) for OFF or the green check mark for ON. Turning off Blow will leave any fluid from the previous step on the 

slide (including Pre-Rinse).

      • When finished editing protocol, click Save (green check mark) and Close.

Create a Template from an Existing Template

      • From the Home Screen, go to Data Manager, then select Template Manager.

      • To the left under Protocols, select Add (+), to add new template.

      • Under Options, select From Existing Template to use a current template and make modifications. A dropdown menu is provided  

         to allow the user to select a template.

      • In the Template Name field, type in the name of the new template.

      • Click create and use the icons to create a template.

     • Once all steps are added, the user can program time, select reagents from a dropdown menu, (to add reagents go to Reagent 

Manager). The user can select the number of washes required in each step under Count, with a maximum of 3 washes per step. 

Blow can be switched on or off by selecting the red (X) for OFF or the green check mark for ON. Turning off Blow will leave any 

fluid from the previous step on the slide (including Pre-Rinse).

      • When finished editing the template click Save (green check mark) and Close.

Delete and Modify Templates 

      • From the Home Screen, go to Data Manager, then select Template Manager.

      • To delete a template, under Custom Templates, select the template to be deleted then click the (X) button to delete.

      • Click Yes in the Confirm window.

      • To edit a template, under Custom Templates, select the template to be edited then click Edit (3 gray arrows) button to make the  

         necessary edits.
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Additional Program Preparation & Setup
Custom Groups

Custom Groups allows the laboratory to create groups of protocols frequently used by the laboratory rather than having to scroll through 

a list of protocols

How to Create a Custom Group

      • From the Home Screen, go to Data Manager, then select Custom Groups.

      • The Group Manager window will appear.

      • On the bottom left of the screen click the Add (+) button and name the Custom Group.

      • Name the Custom Group in the group tab.

      • From Master Protocols list, select the protocols to be added to the Custom Group and click the arrow facing right to add to  

         Assigned Protocols.

      • To remove a protocol from the Assigned Protocols list, select the protocol then click the left arrow.

      • Click Close to save and exit the window.
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Delete a Custom Group 

      • From the Home Screen, go to Data Manager, then select Custom Groups.

      • The Group Manager window will appear.

       • From the Group Manager window the user can delete a Custom Group by selecting the Custom Group and clicking the red X button.

Edit a Custom Group

      • The user can also edit a Custom Group by selecting  the Custom Group and clicking Edit( 3 gray arrows) button.

• Use the green arrows to add and delete protocols in the Custom Group. Select the protocol to be added then click the green arrow  

button pointing right. To delete, select the protocol to be deleted then the green arrow button pointing left. 

      • Click Close to exit and save.
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Slide Fields

Slide Fields allows the user to choose the fields to display in the Slide Details sections of the Slide Manager window and Add Slides 

window when preparing slides.

      • From Data Manager on the Home Screen, choose Slide Fields. The Design Slide Fields window will open.

      • Use the Add (+) button to add fields.

      • Use the Delete (X) button to delete fields.

      • Each Case Field has the following properties:

    	   o Name: The name of the field that can be referenced by other parts of the program.

    	   o Display Text: The text that appears in the Slide Details section of Add Slides, Slide Manager and Assign Slides to identify the field.

Slide Fields are displayed in the Slide Details section of the Add Slides window.

Slide Fields are also displayed in the Slide Details section of the Slide Manager window.
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Slide Map Fields

      • Slide Map Fields is located in the Data Manager dropdown menu of the Home Screen. Upon selection, the Set Slide Display  

          Information window will open.

• There are 4 configurable fields:

      	o Top Line

      	o Middle Line

      	o Bottom Line

      	o Work flow list

• These fields refer to the text that is displayed in the 2 or 3 lines of the Slide Image of a mapped slide on the Staining Main Screen. 

• In each of the 4 fields, choose from the following options in the drop down menu: Case#, Protocol Name, Primary Antibody, 

PreTreatment, Active Step or Block ID.

• The Work Flow List is a display option that will appear in parenthesis by the slide’s protocol under Prepared Slides in both Slide 

Manager and Assign Slides windows. When the user is preparing slides or manual mapping several protocols, the Work Flow List 

is a way for the user to view and keep track of information such as Case#, Block ID, Protocol Name, Primary Ab or PreTreatment 

(based on what is selected to view).

      • Click OK when finished.
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Slide Label Designer

The slide label displays information to be printed and affixed onto the slide.

      • The Slide Label Designer is located under Label Designer in the Tools dropdown menu of the Home Screen. Upon selection, the  

         Design Slide Label window will open.

      • There are 4 columns in the Label Fields section:

      	 o The first column is the Line number (#), indicating the order in which the information will appear on the label.

      	 o The second column is the field displayed in that line. There are 6 Label Field lines which are configurable by the user. The  

	    available options in each drop down menu are: 

	    Instrument + Date

	    Slide ID

	    Protocol Name

	    Pretreatment

	    Antibody

	    Case#

	    Block ID

	    Case # + Block ID

	    Institution

	    Date

      	 o The Type of field (i.e. Text) is displayed in the third column.

      	 o The fourth column is the font size. This ranges from 8 (smallest) to 10 (largest). If not all fields print on a slide label, the  

	   font may be too large. Decreasing the font size should resolve this.

      • A preview of the label is available in the upper right.

      • Several printer settings can be adjusted in the "Printer Offsets" box.

• Click Test Print to test and confirm that desired settings have been achieved.

• Click Save & Close to save changes.

• Visually inspect the test label print to confirm acceptable alignment of the printed content. Adjust Printer Offsets to move text block.

 	 o Decreasing the X-offset will lower the text block from the top of the label.

 	 o Decreasing the Y-offset will shift the text block away from the 2D matrix.

VA L E N T

Case#
Pretreatment
Protocol Name
Antibody
Name - Titer
Institution + Date

VA L E N T

Case#
Pretreatment
Protocol Name
Antibody
Name - Titer
Institution + Date
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Reagent Label Designer 

The reagent label displays reagent information and is to be printed and affixed onto reagent vials.

      • The Reagent Label Designer is located under Label Designer in the Tools dropdown menu of the Home Screen.

      • The first column is the Line # on the label.

• The second column is the field displayed in that line. There are three Label Field lines which are configurable by the user. The  

available options in the dropdown menu are: Reagent Name, Short Name, Catalog #, Lot #, Expiration Date, Lot + Expiration Date.

      • Upon choosing a Label Field option from the Field drop down menu, the Type (i.e. Text) will be displayed in the third column.

      • A preview of the label is available in the upper right of the screen.

      • Seceral Settings are visible in the lower right, these are set up by Biocare Medical Personnel.

      • Click Test Print to test and confirm desired settings have been achieved.

      • Click Save & Close to save changes.
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Report Field 

The system allows a user to configure an IHC Summary report and add or delete information based on lab requirements.

      • From the Home Screen select Tools and go to Print Reports then click Report Generator. 

      • The Generate Reports window will appear, go to Tools and click Configure Report Fields.

      • Select a report from the Select a Report dropdown menu.

      • After selecting IHC Summary, the following appears in the window:

      • Select True to display reagents in IHC Summary report or False to not display reagents in the report.

      • Click Close. 
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Chapter 5: Before Starting a Run
This chapter contains general guidelines for preparing samples, reagents, protocols on the VALENT prior to starting a run.

Slide Preparation 
Slide Specifications

The VALENT works best with slides that do not contain a logo under the frost. If a slide with a logo is used, cover the logo with the slide 

label. Below are slide specifications for the VALENT.

Material Glass, ISO 8037/1

Dimensions
Length: 74.9-76.0 mm (2.95-2.99 in)
Width: 24.64-26.00 mm (0.97-1.02 in)
Thickness: 0.8-1.3 mm (0.03-0.05 in)

Label Area
Width: 24.64-26.0 mm (0.97-1.02 in)
Length: 16.9-21.0 mm (0.67-0.83 in)

Important Note: Pap pens are not required when running slides on the VALENT. Barrier slides should not be used on the VALENT, it will 

obstruct the flow of antigen retrieval solution and dispensing of reagents onto the slide resulting in less than optimal staining results.

Slide Labels

All slides require a water-repellant/hydrophobic tab label for engineered continuous flow of Val DePar and antigen retrieval solution. If 

manually mapping slides, use a VALENT slide label. Failing to use a slide label may yield poor staining quality. The lack of slide labels 

may introduce issues such as slide cracking, as the slide may not load easily without the slide label, and frosted paint from slide melting 

off and mixing with antigen retrieval solution.

When placing the slide label on the slide make sure the whole label is completely flattened and adhered to the slide, especially the 

bottom of the label. If the slide label is not properly placed and sticks up even slightly, liquid flow will be impeded, and reagents will 

wick and yield poor staining quality. Please see diagram below.
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Tissue Placement on Slide

The tissue should be placed in the center of the slide and should not be at the edge or border of slides. Avoid placing the tissue 2mm 

to the left or right edge of the slide. The tissue should be placed 3mm below the VALENT slide label and 5mm above the bottom edge 

of the slide. Please see the reference diagram below.
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Slide Trays 

Run Requirements

Although most runs will have similar protocol conditions and can be processed in the same slide tray, there are certain conditions where 

protocols cannot be processed in the same tray or the same run.

1. DePar and non-DePar slides cannot be on the same slide tray.

2. Non-DePar slides with antigen retrieval require a different slide tray.

3. Varying DePar times requires a separate run.

4. All slides in a slide tray require the same antigen retrieval temperature.

5. All slides in a slide tray require the same antigen retrieval solution.

Inserting Slides into the Slide Tray

      • Lay slide tray on a flat clean surface.

      • Ensure that all slides have a slide label.

      • Place the slide flat, directly below the slide clip making sure it’s centered.

      • Gently push the slide inward so slide is under the slide clip.

      • Slides should be inserted in a straight horizontal motion, do not insert slide at an angle, this may cause the slide to crack.

      • Slides should be straight and evenly spaced between each other.

      • If a slide is not straight, it may affect staining due to possible reagent wicking.
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Removing Slides from the Slide Tray

      • Gently pull the slide out of the slide tray in a straight horizontal motion.

      • Do not pull slides out at an angle, this may cause the slide to crack.

Note: If removing the slide tray immediately after a run completes, residual Aqua Rinse may still be on the slide tray. To eliminate 
residual Aqua Rinse, lift the slide tray at 90 degree angle over the trough to allow Aqua Rinse to spill into the trough.
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Tissue Preparation
Deparaffinization and antigen retrieval are performed onboard the VALENT to streamline the IHC workflow. 

Positive and Negative Controls
To ensure accurate, reliable staining and prevent patient misdiagnosis, quality control is recommended by any or all of the following:

• Positive Tissue Control

Include a tissue sample known to test positive for the marker that requires detection, preferably a sample with a gradient/range of 

reactivity. Test results should indicate positive staining for the given marker if the run was successfully executed.

• Positive Reagent Control

Include more than one antibody and its’ control; if one is positive, the process worked.

• Negative Tissue Control

Include a known negative tissue and apply primary antibody. Test result should indicate negative staining with no background.

• Negative Reagent Control

Replace primary antibody with negative control serum. Test result should indicate negative staining with no background.

Bulk Reagent Preparation

Bulk reagents can be prepared in 8L bulk reagent carboys or 10L bulk reagent mixing carboys. See the table below for reagent 

preparation instructions. Refer to data sheets as needed.

Reagent 8L Bulk Reagent Carboys 10L Bulk Reagent Mixing Carboys

Wash Buffer
Add 400mL of 20X Wash Buffer, 

(VLT8013 MX) to 7.6L DI water.

Add 500mL of 20X Wash Buffer, 

(VLT8013 MX) to 9.5L DI water.

Aqua Rinse
Add 400mL of 20X Aqua Rinse, 

(VLT8012 MX) to 7.6L DI water.

Add 500mL of 20X Aqua Rinse, 

(VLT8012 MX) to 9.5L DI water.

AR-Hi pH
Add 1L of AR-Hi pH, 

(VLT8003 MM) to 4L DI water.

Add 1L of AR-Hi pH, 

(VLT8003 MM) to 4L DI water.

AR-Lo pH
Add 1L of AR-Lo pH, 

(VLT8004 MM) to 4L DI water.

Add 1L of AR-Lo pH, 

(VLT8004 MM) to 4L DI water.
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Instrument Preparation
1. Turn the VALENT on using the main power switch (white switch) found in the electrical panel of the instrument, on the right side.

2. Turn on the computer and open the VALENT application.

3. Double check that both waste carboys are empty and properly connected to the VALENT.

4. Double check that bulk reagent carboys are filled appropriately and properly connected to the VALENT.

5. Remove all slide trays from instrument before priming. The user should prime until there are no remaining bubbles in the carboy 

tubing or probe coil. When priming the dispense manifold, prime until the stream coming from the port is steady and even across 

the 12 ports. 

6. Priming should also be done when refilling the carboys, priming the manifold is not required for this. 

7. Rinse the slide racks with water, and carefully brush away any residual deposits of dried buffer that may be present. This will prevent 

contamination from previous runs.

8. Using both hands, one hand holding reagent rack from front and the other hand from the bottom, load the reagent rack with filled 

reagent vials in the correct orientation; the reagent rack handle should be towards the front of instrument, facing the user. Reagent  

vials must be positioned toward the front of the VALENT, facing the user.

9. To print slide or reagent labels, make sure the slide label printer, reagent label printer, and report printer are attached to the computer.

10. When placing the slide label on the slide, the whole label should be completely flattened and adhered to the slide, especially the 

bottom of the slide label. A slide label that is not completely flat and sticks up even slightly will cause liquid flow to be interrupted. 

When liquid flow is affected, reagents will wick and may yield poor staining quality.

11. All slides require a label. If manually mapping, use a VALENT slide label. Failing to use a slide label may yield poor staining quality.

12. Confirm that all slides are inserted all the way under the slide clips, placed securely in the slide clips, and centered. It is important 

that slide labels are viewable by the barcode camera.

Important Note: Be sure to turn on the instrument before logging into the VALENT Software.
Otherwise, the VALENT Software will automatically be opened in demo mode and the run will not start.
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Drain Waste & Prime Buffers
Remove all slide trays from instrument before priming. The user should prime until there are no remaining bubbles in the carboy 

tubing or probe coil. When priming the manifold, prime until the stream coming from the port is steady and even across the 12 ports.  

Priming should also be done after refilling the carboys, this does not require priming the manifold. This function is found under Tools-> 

Instrument Operations-> Drain Waste & Prime Buffers

Prime Probe

      • Select Prime from the Select Operation section.

      • When Prime is selected, the following are enabled: Probe, Buffers, DePar and Trough.

      • To prime probe, select Probe and adjust the duration of prime in seconds as needed, then click Prime Solution.

      • When priming is complete, click Close or select another priming option.

Prime Buffers

      • To prime, select Prime under Select Operation, then click Buffers under Select a Priming Option.

      • Select Aqua Rinse or Buffer

      • Adjust the duration of prime in seconds as needed and click Prime Solution.

      • When priming is complete, click Close or select another priming option.
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Prime DePar

      • To prime, select Prime under Select Operation, then click DePar under Select a Priming Option.

      • Adjust the duration of prime in seconds as needed and click Prime Solution.

      • When priming is complete, click Close or select another priming option.

Prime Troughs and Manifold

      • To prime, select Prime under Select Operation, then click Troughs under Select a Priming Option.

      • Select the Trough to be primed.

      • To prime the manifold for the selected trough, check the Prime Manifold box.

      • Adjust the duration of prime in seconds, as needed, and click Prime Solution.

      • When priming is complete, click Close or select another priming option.
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Drain Waste

      • This screen can be reached from the Tools and then selecting Instrument Operations.

      • There are 2 selections: Drain Waste or Prime Buffers. 

      • Select Drain under Select Operation, then click the trough to be drained under Select Trough or Wash Station

      • To drain into non–hazardous waste, select Non–Hazardous and click Start Drain. 

      • To drain into hazardous waste, select Hazardous and click Start Drain. 
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Reagent Manager
Add, Delete, and Modify Reagents
Users can add delete and modify reagents under Reagent Manager.

Add a New Reagent 

      • From the Home Screen, select Data Manger, then go to Reagent Manager.

      • To the left of the screen, under Reagent Groups, highlight the Reagent Group to which the new reagent belongs.

      • Use the add button under Reagent Details to add a new reagent.

            

      • Enter the Name, Short Name, Catalog Number, Vendor, Incubation Time, etc. of the new reagent.

      • Select Save (green plus) and Close to save the information.

      • When a reagent is added to this screen it will be added to Inventory Manager as a reagent for selection.
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Delete a Reagent 

      • From the Home Screen, select Data Manager, then go to Reagent Manager.

      • To the left side of the screen, under Reagent Groups, click the Reagent Group to which the new reagent belongs.  

      • From the reagent table, click the reagent to be deleted.

      • Use the delete button (X), under Reagent Details to delete a reagent.

      • Select Close to save the information. 

Modify a Reagent 

      • From the Home Screen, select Data Manager, then go to Reagent Manager.

      • Under Reagent Groups, click the Reagent Group under which the reagent is categorized.

      • From the reagent table, click the reagent to be modified.

      • Use the Edit (3 gray arrows) button under Reagent Details to modify a reagent.

            

      • Make the necessary changes then click Save (green check mark) and Close to exit.
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Import a Reagent from Reagent Manager

      • From the Home Screen, select Data Manger, then go to Reagent Manager.

      • To the left side of the screen, under Reagent Groups, click the Reagent Group under which the reagent is categorized.

      • Use the Import (green arrow) button under Reagent Details to import a reagent.

            

      • The Reagent Master List window will appear.

           

      • Select the reagent to be imported and click Import Selected Reagents 

      • Select Close to save the information and exit out of window.

Note: Reagents in gray signify that they are already part of the Reagent Master List and do not need to be imported, while reagents in 
black  have not been imported to Reagent Master List. Only Biocare Medical Reagents can be added to the Reagent Master List. 
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Print a Reagent Label 

      • From the Home Screen, select Data Manager, then go to Reagent Manager.

      • Use the Print button under Reagent Details to open the Print Reagent Labels window.

      • To the left of the screen, under Reagent Groups, click the Reagent Group under which the reagent is to be categorized.

      • In the reagent table, click and highlight reagent to be printed or choose Select All to print out all reagent labels.

      • Click Print Labels.
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Add a Reagent in Mix Group 

The Mix group is used to designate components of chromogens, enzymes, and ancillary reagents which will be used by the instrument 

to perform on-board mixing of these reagents.

            

      • From the Home Screen, select Data Manger, then go to Reagent Manager.

      • To add a mixing component reagent under Mix, click the desired subgroup category. (Chromogen Components, Enzyme  

Components, Ancillary).

      • Click the Add (+) button below Reagent Details box to add a new reagent.

      • Enter the Name, Catalog Number, Short Name, Vendor, and Incubation Time.

      • Select Stability (Stable or Unstable) to designate whether the reagent needs to be made just before being dispensed or can be  

         made at the beginning of the run. 

               o Stable and unstable reagents are loaded in a 20mL reagent vial.

      • Once all information has been entered, click Save (green check mark) and click Close.
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Specify Mixing Properties 

The user can specify whether mixing of available Enzyme, Chromogen, and Ancillary Reagent Groups is performed online, by the 

instrument during a run, or offline manually. Once set to Mix, the Mixing Components link will be available in the top right corner of 

the Reagent Details box.

Chromogen Example

      • From the Home Screen, select Data Manger, then go to Reagent Manager.

      • Under Reagent Groups, select from either Chromogen, Ancillary, or Enzyme Components.

• Click the Add (+) button under Reagent Details and fill out Reagent Details such as Name, Short Name, Catalog Number, Vendor, 

Mix or Regular, Waste Disposal Properties, Mixing Properties and Stability.

• For Stability, Stable means the mix is stable, Unstable means the mix is unstable and must be used immediately by the 

instrument.

• Once Mix is selected from a dropdown menu, Mixing Components can be accessed.

      • Use the Mixing Components window to designate the volume (in μL) of chromogen buffer and the volume (in μL) of chromogen substrate. 
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Volume Calculation for Mixing Reagents

There are 2 dead volumes to consider when mixing reagents online that is determined by the VALENT Software:

      • About 300μL is lost during the mixing process itself, which should be accounted for in the sample calculations below.

      • There is a 50μL dead volume for all reagent and mixing vials due to the limitation of probe.

Below is an example of how dead volumes work for mixing reagents.

DAB Reagent = DAB Chromogen + DAB Buffer

The dispense volume per slide is 300μL with an extra 20μL needed, (the extra 20μL volume is to compensate for lost volume 

during slide application) for a total of 320μL. 

DAB Reagent
    Volume for 12 slides=  12 * 320μL= 3840μL

    Dead volume = 50μL

    Total DAB Reagent required for 12 sides = 3890μL

a. DAB Chromogen
     Volume needed for 12 slides = 240μL

     Dead volume = 50μL

     Total volume = 290μL

b. DAB Buffer
     Volume for mixing 12 slides = 3950μL

     Dead volume = 50μL

     Total = 4000μL

After mixing buffer and chromogen, the total volume of DAB Reagent will be 4190μL (240μL + 3950μL). During the mixing 

process, 300μL is lost leaving 3890μL, (4190μL -300μL).
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      • From the Chromogen Components list on the left, highlight the catalog number for the chromogen buffer and click the right                 

         arrow button to add to the list on the right.

      • Click the Volume field dropdown menu to select the desired volume (in μL) of buffer.

      • Add Chromogen (concentrate) to the mix in the same way. The minimum volume required is 100μL. 

      • To delete a component from the list on the right of the screen, highlight it in either list and click the back arrow button.

      • Click Save, then Close to exit.

Important Note: When setting up mixing components, reagents that require larger volumes should be added first.
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Inventory Manager
Inventory Manager allows the user to enter and track reagent lot, expiration, starting volume, current volume, and serial number to be 

used on the instrument.

View Reagents 

      • Inventory Manager can be opened from the Data Manager dropdown menu from the Home Screen. When Inventory Manager is chosen,  

      the Reagent Inventory Manager window is displayed. 

      • The list of reagents can be sorted by any field by clicking on the header. Reagents can also be sorted by the Reagent Step  

         dropdown menu, located to the top left of the screen. 

      • A search field is provided to quickly find a reagent.
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Add Reagents 

• When Inventory Manager is chosen, the Reagent Inventory Manager window is displayed. 

• Select the Add (+) button to add a reagent.

• The Add Reagent Inventory window will allow the user to enter reagent information such as Catalog Number, Lot Number, 

Expiration Date, Starting Volume and Serial Number.

      • The Reagent Lookup button is located next to Catalog field to quickly pull up reagents already in inventory.

      • Click Close to exit.

Important Note: When Inventory Manager is opened from the Data Manager dropdown menu in the Home Screen, the Register Reagents 
button is displayed.
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Delete Reagents and Clean Inventory 

      • Select Inventory Manager.        • To delete a reagent, select the reagent to be deleted and click the Delete (X) button.

• The user can click Clean Inventory to clear a list of inventory. The system will only allow the user to Clean Inventory if the reagent   

is expired and contains a volume below 350μL.

• The Current Volume of reagents is calculated by the VALENT Software as the reagent is used up during staining runs.

• Click Close to exit.

Print Labels in Inventory Manager	

      • Select Inventory Manager.

      • Select the reagent that requires a print label and click the barcode button. 

      • Click Close to exit.
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Register Reagents in Inventory Manager 

New reagents can only be scanned into inventory when the user initially logs into the system. For example, if a protocol has been run or 

system cleaning executed, the user won’t be able to scan reagents into inventory. To scan reagents into inventory, the user will have to 

exit the software and log in again. The user has the option of manually entering reagents into inventory.

      • Select Inventory Manager. 

      • Select the Register Reagent (3 gray arrows) button to scan.

      • To scan the reagents, click Start Scan.

      • To save these listed reagents to the inventory, click the Save button. Reagents with valid lot numbers and expiration dates are  

          saved to the inventory and this window is closed.

      • To cancel scanning, click Cancel.

      • Click OK once scanning is completed.

Important Note: The use of expired reagents is strongly discouraged in a clinical environment. Refer to the reagent label description 
and data sheets.
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Protocol Manager 

Protocol Manager can be reached from the Data Manager dropdown menu of the Home Screen. Use the Protocol Manger module to 

save, design, and manage protocols.

Important Note: When programming protocols, it is important to consider environmental conditions. Lower boiling temperatures and 
higher evaporation rates must be evaluated for labs at a higher elevation. If the optimal temperature for antigen retrieval is 98°C with 
an elevation of 1500 feet, the temperature for antigen retrieval may need to be adjusted to 95°C if the elevation is above 3750 feet. 
Please call Technical Support if you have further questions.

Description of Template Manager Icons

Icon Description Icon Description

Add a new step at the end of a protocol. Move up the selected step in a protocol.

Delete a step at the end of the protocol. Move down the selected step in a protocol.

Insert a new step before the selected step in a 

protocol.
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Protocol Manager Features

• The user can filter the list of protocols by choosing All Protocols or by choosing a Custom Group in the Protocol’s dropdown menu.

• A filtered list of protocols will appear below the Protocol’s dropdown menu based on the dropdown choice. The user can check the 

Show Biocare Protocols box to only view additional Biocare Protocols. This is located to the bottom left of the window.

• Biocare Protocols cannot be edited, only Custom Protocols can be edited.

• Use the buttons to the bottom left of the window to add or delete a protocol. To create a New Protocol select the Add (+) button, 

the following selection is available: Create New Protocol, Create from a Template, and Create from a Selected Protocol.

      • To delete a protocol, highlight the protocol and click Delete Selected Protocol (X), located to the bottom left of the window. 

Important Note: There are two delete (X) buttons, select the one under Show Biocare Protocols

      • The information about the selected protocol will appear in the Protocols section on the right half of the window including the name  

        of the protocol, dispense volume and protocol steps.

      • Use the buttons located on the bottom of screen to edit the protocol along with clicking on the particular step that requires  changes.

        The user can change the following items in a protocol:

      	  o Modify existing protocol name.

      	  o Modify existing reagent, blow, volume, time, wash type and wash count for any step in a protocol.

      	  o Use buttons to add, insert, delete or move steps in the protocol.

Important Note: When creating or editing a protocol from a Template or a Selected Protocol, click out of current cell and to a different 
cell to lock in the changes.  
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Create a Protocol

There are three ways to create a protocol; the user can either Create a New Protocol, Create from a Template or Create from a Selected Protocol.

Create a New Protocol

      • From the Home Screen, go to Data Manager, then select Protocol Manager.

      • To the bottom left of Protocol Manager window select the Add (+) icon located to the bottom left of the screen.

      • Once Add (+) is selected, select Create New from the options.

      • On the top right side of the window, add the protocol name.

      • The dispense volume is 300μL for all protocols.

      • Select Add (+) located at the bottom of the window, this opens the Add a New Step window.

      • Using the dropdown menu Select a Step along with the reagent required for this step, then click Add Step.

      • Use the icons provided to finish creating a protocol.

      • Once all steps are added, the user can program time and select reagents from a dropdown menu (to add reagents go to Reagent 

Manager). The user can select the number of washes required in each step under Count, with a maximum of three washes allowed 

per step. Blow can be switched on or off by selecting the red (X) for OFF or the green check mark for ON. Turning Blow off will 

leave any fluid from the previous step on the slide (including Pre-Rinse).
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Create a Protocol from a Template

      • From the Home Screen, go to Data Manager, then select Protocol Manager.

      • To the bottom left of Protocol Manager window select the green Add (+) icon.

      • Once Add (+) is selected, select the Create from a Template option.

      • A Select an Item window will appear, select the template required, and click OK.

      • On the top right side of the window, edit the protocol name if needed.

      • The dispense volume is 300μL.

      • Use the icons provided to finish creating a protocol.

      • Once all steps are added, the user can program time and select reagents from a dropdown menu (to add reagents got to Reagent 

Manager). The user can select the number of washes required in each step under Count, with a maximum of 3 washes per step 

allowed. Blow can be switched on or off by selecting the red X for OFF or the green check mark for ON. Turning off Blow will leave 

any fluid from the previous step on the slide (including Pre-Rinse).

      • When finished editing protocol, click Save & Close.
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Create a Protocol from a Selected Protocol

• From the Home Screen, go to Data Manager, then select Protocol Manager.

• To the left under Protocols, find the protocol to be copied. In the Protocol field, use the dropdown filters to select All Protocols or   

Custom Groups. Custom Groups are the user’s preferred list of protocols.

• To find Biocare Medical Protocols, click Show Biocare Protocols located on the bottom left.

• Select desired protocol to create a new protocol.

• To the bottom left of Protocol Manager window select the green Add (+) icon located below Show Biocare Medical Protocols. 

   

• Once the green Add (+) icon is selected, select the Create from the Selected Protocol option.

• On the top right side of the window, under Protocol name, COPY will be added at end of the protocol name, edit the Protocol 

name if needed.

• The dispense volume is 300μL.

• Use the icons provided to finish creating a protocol.

• Once all steps are added, the user can program time and select reagents from a dropdown menu (to add reagents go to Reagent 

Manager). The user can select the number of washes required in each step under Count, with a maximum of 3 washes per step 

allowed. Blow can be switched on or off by selecting the red (X) for OFF or the green check mark for ON. Turning off Blow will 

leave any fluid from the previous step on the slide (including Pre-Rinse).

• When finished editing, click Save & Close.
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Chapter 6: Prepare and Start a Run
Once all required reagents and protocols have been entered into the VALENT Software by the administrator, both administrators and 

regular users can use this chapter as a guide to setup and begin their staining run. 

Important Note: Before starting this chapter, be sure to follow the instrument preparation section. In particular, be sure to turn on the 
instrument before logging in to the VALENT Software, otherwise, the VALENT Software will automatically open in demo mode, not 
allowing the user to start the run.

There are two ways to processes slides described below.

Process Overview 1
Summary of the run setup process by Scanning Slide Labels. Details of each step are provided within this chapter.

1. Login 2. Select 
Prepare Slides

3. Print Labels 4. Scan Slides

8. Start Staining5. Prepare & Load 
Reagents

6. Scan or Map 
Reagents

7. Pre-Start 
Checklist

Process Overview 2
Summary of the run setup process using Manual Mapping of Slides. Details of each step are provided within this chapter.

1. Login 2. Select 
Map Slides

3. Manually Assign 
Slides

4. Load VALENT 
Labeled Slides

8. Start Staining5. Prepare & Load 
Reagents

6. Scan or Map 
Reagents

7. Pre-Start 
Checklist
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1. Login 
Login to the VALENT Software. Enter username and password in the dialog box.

Note: Default User ID is admin, default password is valent.

            

  

Home Screen

            

1. Menu Bar 2. Run Designation Buttons 3. Run End Time 4. Reagent Rack 5. System Lid Status 6. Reagent Rack Lock/Unlock Status 

7. Reagent Rack Temperature 8. Carboy Reagent Levels 9. Slide Tray Position 10. Slide Tray Lock/Unlock Status 11. Slide Tray Status
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2. Prepare Slides
Prepare Slides is the orange Run Designation Button that is located to the top left of the Home Screen. It is the starting point to begin 

a staining run. Prepare Slide functions are listed below.

Prepare and Edit Slides 

     • From the Home Screen select Prepare Slides.

     • The Add Slides window will allow the user to enter Slide Details, such as Case #, Pathologist, Patient Name, etc. 

    • All slides added in the Add Slides window will be labeled with the same Slide Details such as Case # or Block ID. To enter 

different Slide Details, go to the Data Manager-> Slide Fields and enter slide details desired. See Slide Fields section of Chapter 

4 for more information.

     • Choose from a list of protocols under Available Protocols dropdown menu. Filter by All Protocols or Custom Groups. 

     • Select the desired protocol from the list of Available Protocols (hold the CTRL button down to select more than one protocol).

     • Click the green right arrow to select the protocol.

• If positive and/or negative controls are desired, check the box under the plus (+) sign to order a positive control and check the  

box  under the minus (-) sign to order a negative control. 

     • Click OK.

     • The Slide Manager window will open for additional features including printing slide labels, copying slides, importing slides, saving  

       slides, deleting slides, and viewing a reagent worksheet.

      • Slide Detail, such as Case#, Pathologist, Patient Name, Block ID, etc. can be modified by clicking on the cell to be modified. 

     • Protocol information, such as protocol name, reagent steps and their properties, can be deleted, inserted, added or moved by 

        clicking on the cell to be modified. 

     • Skip to Print Labels of Chapter 5 of the Protocol Manager section if the user does not need further instruction on how to add,  

        modify, copy, print slides and reagent worksheet, etc.

Important Note: When modifying Protocol and Slide Detail information, click out of the current cell and to a different cell to lock in 
the changes. 
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Add, Delete and Copy Slides from Slide Manager

     • From the Slide Manager window, there are several buttons to the bottom left of the window.

     • Additional slides can be added by clicking the plus (+) sign slide icon. 

     • This will bring the user back to the Add Slides window. The user can then select additional slides for processing.

     • The user can make copies of a Prepared Slide by highlighting the slide to be copied and clicking the multiple slide icon from the  

        Slide Manager.

     • Enter the number of copies.
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     • A prepared slide can be deleted by checking the box next to the slide to be deleted and clicking the red (X) sign slide icon.

Important Note: Make sure only the slides desired to be deleted are check-marked or everything will be deleted.
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Import Slides from Slide Manager

     • From the Slide Manager window, there are several buttons to the bottom left of window.

• Processed Slides, Recent Slides, Pending Slides  and Saved Slides can be imported by clicking the Import Slides (blue arrow 

pointing down) sign slide icon.

     • The Import Slides Window will appear.

           

    • Select which set of slides are to be imported from the dropdown menu, check the box for each required slide and click Import 

Selected Slides.
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Save Slides for a Later Run 

The user can prepare slides for a future run when the instrument is not running or while a run is in progress.

     • To save slides to run later, click the Save Slides button on the Prepared Slide screen.

     • The Save Slides To Run Later window will open.

                

     • To save only Un-Mapped Slides (slides that are still in the list), check the box next to Save Un-Mapped Slides.

     • To save only the checked slides under Un-Mapped slides, select Only CHECKED Slides.

     • To save both checked and unchecked slides within unmapped slides, select ALL Slides.

     • To save only mapped slides, check the box next to Save Mapped Slides.

     • Enter a name for the list of slides in the box.

     • Click Save.

     • A representation for each existing list appears on the right. To delete an existing list, select and click Delete.
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3. Print Labels
Once the user has set up slides from Prepared Slides in the Slide Manager window, follow the steps to start a run. 

Important Note: Prior to printing a new batch of slide labels for a run, use the "FEED" button on the top of the label printer to advance 
the slide label roll, and discard the first, blank label. See section on how to Prepare and Edit Slides in the beginning of this chapter to 
obtain detailed information on how to set up slides and protocols. 

 

     • From the Slide Manager Window under Prepared Slides, once all slides have been ordered and information is correct, select the 

print button to print slide labels, located to the bottom right. 

     • Make sure each slide that requires printing has a check mark next to its box.

     • Once the labels are printed, place the labels on the slides and load the slides onto the slide tray. 

     • Select Save and Close. 

     • The Assign Slides window will appear which is required to start scanning.

Important Note: When placing the slide label on the slide make sure the whole label is completely flattened and adhered to the slide, 
especially the bottom of the label. If the slide label sticks up even slightly, current flow will be impeded and reagents will wick and 
yield poor staining quality.
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View and Print Reagent Worksheet

     • From the Slide Manager window, select the slides to be processed then click Show Reagent Worksheet button, located to the  

        bottom left under Prepared Slides.

           

     • Choose from the drop down: Prepared Slides or All Slides to view Mapped Slides.

     • All slides from the chosen dropdown menu are listed on the left, under Slide List.

     • All reagents required to run these slides are listed on the right.

     • Selecting specific slides from the Slides List will only show the reagents needed for those slides in the Reagent List on the right.

     • To print the Reagent List, click Print Reagent Worksheet.

     • To print labels, check the boxes next to the reagents that require labels and click Print Labels. Select All is available if required.

     • Reagent Worksheet may also be printed from the Tools dropdown menu of the Home Screen, once reagents are mapped.

     • Click Save & Close when finished.
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4. Scan Slides
Once the user has set up slides from Prepared Slides in the Slide Manager window, follow the steps to start a run. 

Important Note: See section on how to Prepare and Edit Slides in the beginning of this chapter to obtain detailed information on how 

to set up slides and protocols. 

 

     • From the Slide Manager Window under Prepared Slides, once all slides have been ordered and information is correct, select the 

print button to print slide labels, located to the botton right. 

     • Click Save + Close

     • The Assign Slides window will appear. Select Scan Mode.

     • Check the box for each slide tray that contains slides, the Select All checkbox is available if all 4 slide trays contain slides.

     • Click Scan Slides to begin slide scanning. Scanning will cease once all printed slide labels have been detected.
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     • If the user requires more slides, the Add Slides button is located to the bottom of the Assign Slides window.

• The Home Screen will display all scanned slides in the Slide Tray. Slide Positions will appear green under Assign Slides, once 

slides have been detected.

     • Use the mouse to hover over a scanned slide for the Slide Information window to appear.

     • Once all slides have been scanned, the Prepare Reagent button will be accessible.
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5. Prepare and Load Reagents
     • Once desired slides have been loaded and scanned, click Prepare Reagents from the Assigned Slide window to open the Load  

       Reagents window.

     • A list of all reagents required for the run will be displayed.

• A lot and expiration link is available to view and enter Lot Numbers and Expiration Dates for the reagents listed. This information 

will only be tracked for this run. If a permanent entry is needed, go to the Inventory Manager.

• If reagent labels are needed, check the box for each reagent that a label is needed or check Select All for Printing and click Print 

Label.

• Label reagent vials. Reagent labels should be placed next to opening of vial and centered.

• If using hematoxylin, gently mix the reagent by inverting the vial twice before loading onto the reagent rack.
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6. Scan or Map Reagents
Ensure all reagent vials are properly labeled and load all reagents listed in the reagent rack in order of use, to facilitate optimal reagent 

dispensing time.

     • Choose from three loading reagent options: Auto Map, Manual Map, and Scan Reagents.

          o Auto Map will load reagents in the reagent rack in the order listed in the Load Reagents screen. Load Reagents is based 

on which slides were assigned first. For example, if TTF-1 is entered manually in positions A6-A12 first and then CD20 is 

added in A1-A5. Load Reagents will list TTF-1 first before CD20. It is the user’s responsibility to physically load the reagent 

vials in the auto mapped locations correctly.

          o Manual Map allows the user to choose a reagent from the Load Reagents list and then choose the position in the reagent 

rack to which the user desires it to be loaded. Repeat until all reagents in the Load Reagents list have been mapped. It is 

the user’s responsibility to physically load the reagent vials in the manually mapped locations correctly.

          o Scan Reagents will instruct the barcode camera to scan the reagent rack until all required reagents have been located. It 

will automatically detect reagent levels.

     • After all of the required reagents have been loaded and scanned, mapped or auto-mapped reagents require the user click Levels  

        to detect reagent levels are sufficient for the run.
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7. Pre-Start Checklist
Use the Load Reagents screen as a Pre-Start Checklist to verify that the appropriate carboys have been filled, and hazardous and non-

hazardous carboys have been emptied. Check the carboy status categories under Bulk & Waste.

          

     •Make sure that all reagents and mixing vials have been loaded as shown on the screen and volumes are sufficient. Do not re-use 

mixing vials, always use new, clean mixing vials. oThe Bulk & Waste section of Load Reagents window provides information about 

the required volumes and waste capacities for each carboy in support of the programmed run. 

     • Confirm that sufficient DePar Solution is available for the upcoming run, then check the Confirm DePar Volume box.

      • Check the buffer lines above the Z-head for air bubbles, if air bubbles are present refer to Drain Waste and Prime Buffers of Chapter 

5 for instructions on how to remove air bubbles.

     • The Delayed Run checkbox on the top right side of the Pre-Start Checklist window allows the user to set a delayed start time for 

the run. To set Delayed Run:

          o Check the Delayed Run box under Load Reagents 

          o Select the Start Time

          o Optional: If required select Rinse Slides, Rinse Buffer Interval Time and Aqua Rinse/Buffer

Important Note: The Delayed Run box will only appear once the reagent levels have been checked.
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If the VALENT Cart Battery is not fully charged, the software will display a notification message with an estimation of the additional 

delay, as shown above.
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8. Start Staining 
     • Once everything has been checked, select Start Run.

   • Note: If the Delayed Run box was selected in the Pre-Start Checklist screen, after clicking Start Run, the Run will start in… 

countdown clock will appear in orange at the top of the Home Screen. The run automatically begins after the countdown is 

completed. Alternatively, the user may select Start Now or Cancel Run.

Slide and Reagent Information

Once the run has started, the user can view Slide Information by using the mouse cursor to hover over a slide.
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Reagent Information

Once the run has started, the user can view Reagent Information by using the mouse cursor to hover over a reagent. 

Once the run has started, the user can view Reagent Information by using the mouse cursor to hover over a reagent.

Run Complete

When a run is complete, slides will turn blue and a Run completed notification will appear.
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Clear the Completed Trays

Once a run is complete the user can clear tray.  There are two ways to do this:

     • Select Clear the Completed Trays from the Tools dropdown menu of the main screen. This will release, or unlock, the slide tray 

from the instrument to allow the user to remove the slides. 

     • At the end of run an icon appears below the slide trays. Clicking this icon allows the user to clear reagents and the slides in the  

VALENT Software. 

     • Reagents are automatically cleared after the run completes.
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Map Slides

 The VALENT allows manual mapping of slides under Map Slides.

Process Overview 2
Summary of the run setup process using Manual Mapping of Slides. Details of each step are provided within this chapter.

1. Login 2. Select 
Map Slides

3. Manually Assign 
Slides

4. Load VALENT 
Labeled Slides

8. Start Staining5. Prepare & Load 
Reagents

6. Scan or Map 
Reagents

7. Pre-Start 
Checklist

1. Login 

Login to VALENT Software. Enter username and password in the dialog box.

Note: Default User ID is admin, default password is valent.
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2. Map Slides 

     • From the Home Screen select Map Slides and the Assign Slides window will appear.

     • Multiple view options are available from the Select Protocols dropdown menus. Below is a description of each protocol group.

Protocol Description

All Protocols Lists every protocol in the system.

Custom Group
Displays protocols from a particular Custom Group. An additional dropdown exists to filter by specific  

Custom Group.

Prepared Slides

Only shows the Protocols from the Prepared Slides section of the Slide Manager Window.

An additional dropdown menu allows the user to view All Prepared Slides or Printed Slides (both Prepared 

Slides and Printed Slides come from the Prepared Slides section of the Slide Manager window; printed slides 

have an asterisk next to the protocol name).
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3. Manually Assign Slides

     • From the list of protocols, choose the protocol to assign and then click the slide position where the user will load the slide, the  

        protocol will be assigned to that slide position.

     • To assign the same protocol to an entire tray, choose the protocol and click Map Tray.

     • If positive and/or negative controls are desired, check the box under the plus (+) sign to order a positive control and check the box  

       under the minus (-) sign to order a negative control. 

     • After mapping slides to slide tray, print a copy of the Slide Layout Report to keep track of each slide’s location.

     • To Print the Slide Layout Report go to Tools -> Print Reports -> Slide Layout Report.

     • To remove a slide from the slide tray click the slide to be deleted. 

     • Add Slides is available if more protocols are needed.
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4. Load Labeled Slides

• All slides require a VALENT Slide Label. If slide does not have a label, use a VALENT Slide Label. Failing to use a slide label may 

yield poor staining quality.

5. Prepare and Load Reagents

• Once desired slides have been loaded and scanned, click Prepare Reagents from the Assigned Slide window to open Load Reagents 

window.

• A list of all reagents required for the run will be displayed.

'

    • A lot and expiration link is available to view and enter lot number along with the expiration date for the reagents listed. This 

information will only be tracked for this run. If a permanent entry is needed, go to the Inventory Manager.

     • If reagent labels are needed, check the box for each reagent that a label is needed or use the Select All for Printing checkbox.

     • Label reagent vials. Reagent label should be placed next to opening of vial and centered.

     • If using hematoxylin, gently mix the reagent by inverting the vial twice before loading onto the reagent rack.
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6. Scan or Map Reagents

    • Ensure all reagent vials are properly labeled and load all reagents listed in the reagent rack in order of use, to facilitate optimal  

        reagent dispensing time.

    • Choose from three loading reagent options: Auto Map, Manual Map, and Scan Reagents.

          o Auto Map will load reagents in the reagent rack in the order listed in the Load Reagents screen. Load Reagents is based on 

which slides were assigned first. For example, if TTF-1 is entered manually in positions A6-A12 first and then CD20 is added 

in A1-A5. Load Reagents will list TTF-1 first before CD20. It is the user’s responsibility to physically load the reagent vials in 

the auto mapped locations.

          o Manual Map allows the user to choose a reagent from the Load Reagents list and then choose the position in the reagent rack 

to which the user desires it to be loaded. Repeat until all reagents in the Load Reagents list have been mapped. It is the user’s 

responsibility to physically to physically load the reagent vials in the manually mapped locations.

          o Scan Reagents will instruct the barcode camera to scan the reagent rack until all required reagents have been located. It will 

automatically detect reagent levels.

'

    • If reagents are manually mapped or auto mapped, the user is required to click the Levels button to detect reagent levels before 

starting a run.
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'

    • If reagents are scanned, the VALENT will automatically detect reagents levels without having to click Levels.

'

    • Manual override of reagents is available. Once the vials have been checked, if a reagent is highlighted in red indicating the volume 

is low, the user can manually override the system and enter the correct volume in the vial.

    • Once reagent levels have been manually entered or scanned, the user can enter reagent lot numbers.



88

7. Pre-Start Checklist

Use the Load Reagents screen as a Pre-Start Checklist to verify that carboys have been filled, hazardous and non-hazardous carboys 

have been emptied. Check the carboy status categories under Bulk & Waste.

'

    • Make sure that all reagents and mixing vials have been loaded as shown on the screen and volumes are sufficient. Do not re-use    

 mixing vials, always use new, clean mixing vials.

    • The Bulk & Waste section of Load Reagents window informs the user that carboys have adequate bulk reagent and waste capacity 

for the run.

    • Confirm that sufficient DePar Solution is available for the upcoming run, then check the Confirm DePar Volume box.

    • Check the buffer lines above the Z-head for air bubbles, if air bubbles are present refer to Drain Waste & Prime Buffers of Chapter 

5 for instructions on how to remove air bubbles.

    • The Delayed Run checkbox on the top right side of the Pre-Start Checklist window allows the user to set a delayed start time for  

 the run. To set Delayed Run:

          o Check the Delayed Run box under Load Reagents 

          o Select the Start Time

          o Select Rinse Slides, and Rinse Buffer Interval Time 

          o Select Aqua Rinse or Wash Buffer

Important Note: The Delayed Run box only appears once the reagent levels have been checked
    • Once everything has been checked, the user can either Start Run or select Delayed Run.
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8. Start Staining

    • Once everything has been checked, select Start Run.

• Note: If the Delayed Run box was selected in the Pre-Start Checklist screen, after clicking Start Run, the Run will start in…  

countdown clock will appear in orange at the top of the Home Screen. The run automatically begins after the countdown is 

completed. Alternatively, the user may select Start Now or Cancel Run.
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Chapter 7: System Cleaning
The VALENT should be cleaned on a daily, weekly, and monthly basis. The use of appropriate personal protective equipment (PPE) is 

recommended during all instrument cleaning procedures. Failing to clean the instrument may result in poor quality staining.

Daily

• Rinse the used slide racks in tap water and dab (do not wipe) dry with a paper towel after every run. Always wear gloves while 

performing this cleaning step.

• Inspect slide trays for residue from DAB, hematoxylin or other unwanted debris.  If debris or residue is observed, perform weekly 

slide tray cleaning as described in the "Weekly Slide Tray Cleaning" section on page 92 of this manual.  

• Place the empty slide racks on a clean, dry surface for storage until the next use.

Weekly

Perform Val DAB Away and Val Clean cleaning at least once a week or every 250 slides to clean the reagent probe followed by Weekly 

Slide Tray cleaning to remove residue from slide trays, troughs surfaces, trough level sensors, and trough filters.

Procedure for DAB away cleaning:

• From the Home Screen select Tools -> Instrument Operations -> System Cleaning.

• The Clear Trays reminder message will appear. Click Ok to confirm the trays have been removed from the instrument.

• The Clear Reagents reminder message will appear. Click Ok to confirm the IHC reagents have been removed from the rack.

• Next, the Cleaning Routines summary window will appear. To proceed with system cleaning or carboy cleaning, click the 

corresponding Clean Now button.

• The System Cleaning Window will appear. Follow each instruction and check mark each box for Prerequisites for Cleaning once 

the task is complete.
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Program Cleaning 

• Once all boxes have been check marked, click Verify Carboy & Reagents and ensure there is sufficient reagent in the bulk reagent 

carboys and waste carboys have capacity for waste.

• Complete the final checklist step as described in the PreRequisites for Cleaning checklist.

    • Click Start Cleaning when carboys have been verified.

• The user can select View Cleaning Log on the top right-hand side and print the log if needed.

• Close the window.

• Proceed to Monthly Carboy Cleaning if required, or click Exit. 

• If no additional cleaning is required at this time, close the Stainer Application before beginning a new staining run.
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Weekly Slide Tray Cleaning

Residue and/or debris that accumulates on the slide racks of the VALENT can be easily removed by application of a sodium bicarbonate 

based paste.  It is recommended that the slide trays are cleaned at least once per week to avoid build up of unwanted residue.

• For each tray to be cleaned, begin by mixing approximately 10 grams of sodium bicarbonate with 15 ml of water to form a soft 

paste. (i.e. Combine 40 grams of sodium bicarbonate with 60ml of water to clean all 4 trays at once.)  

• Use a soft, short bristled brush to apply the sodium bicarbonate paste to all surfaces of the slide tray, including the bottom surface 

of the slide trays.  

• If needed, the paste may be left to sit for up to 5 minutes to aid with residue and debris removal.  

• Gently agitate the brush and paste over the slide trays surfaces, paying extra attention to the area around the slide clips.  Re-apply 

and repeat as needed in areas where visible residue persists.

• Rinse slide trays thoroughly under cool tap water to remove all paste. 

• Pat dry with a soft cloth, and allow to air dry thoroughly before next use.

• With all the slide trays removed, clean the interior of the VALENT troughs by wiping the following surfaces with a 70% Isopropyl 

alcohol lint free wipe.

		  • interior bottom of all four troughs

		  • interior rail guides for slide trays

After all trough surfaces have been wiped clean, rinse the interior surfaces and trough filters by pouring 200 ml of Aqua Rinse into each 

trough. Ensure that the top surfaces of each trough filter is rinsed with Aqua Rinse.



93

Monthly

Perform Carboy Cleaning monthly to disinfect carboys and internal supply lines. Diltued Lysol® I.C. Quaternary Disinfectant Cleaner is 

used for this procedure. Follow the dilution directions specified on the Lysol bottle. A minimum of 8 liters of diluted Lysol cleaner are 

needed for this procedure.

• From the Home Screen select Tools -> Instrument Operations -> System Cleaning.

• The Clear Trays reminder message will appear. Click Ok to confirm the trays have been removed from the instrument.

• The Clear Reagents reminder message will appear. Click Ok to confirm the IHC reagents have been removed from the rack.

• Next, the Cleaning Routines summary window will appear. To proceed with carboy cleaning, click the corresponding Clean

Now button.

• The Carboy Cleaning with Lysol window will appear. Follow each instruction and check mark each box in the list once the

task is complete.

• Once all boxes have been check marked, click Verify Carboy to initiate Carboy Cleaning Protocol.
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• Once Lysol cleaning is complete, the Carboy Cleaning Protocol will pause and a new checklist will appear.

• Empty remaining Lysol solution from the bulk carboys and initiate rinsing with DI water as prompted in the checklist.

• Click Verify Carboys, then Continue to complete the Carboy Cleaning Protocol.

Carboy Cleaning Continued
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• Once cleaning is completed, the System Cleaning Screen will show Cleaning Complete.

• The user can select View Cleaning Log on the top right-hand side to view or print the logs if needed.

• Close the window.

• The Cleaning Routines summary window will appear. Click Exit. Close the stainer application before beginning a new

  staining run.

Drain the Secondary Containment Sump

Drain the secondary containment sump on a monthly basis or if a large spill is caught by the sump.

•	To drain the secondary containment sump, take an empty container that will fit under the VALENT Cart and place 

it below the  drain plug, located underneath the VALENT Cart towards the middle front (see diagram).

•	Unscrew the drain plug by turning the knob clockwise as viewed from above.

•	Allow the liquid to drain into the empty container.

•	Re-seal the secondary container sump by screwing the plug back in.

•	Dispose of the liquid collected into the appropriate container.
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Additional Cleaning of the Instrument

•  Remove the slide racks and soak using Lysol® I.C. Quaternary Disinfectant Cleaner, wiping if necessary, being careful not to bend 

the slide clips.

•	With all the slide trays removed, clean the interior of the VALENT by wiping the troughs, with 70% Isopropyl alcohol lint free wipe, 

being careful to avoid the filters in the troughs.

•	Wash Buffer salt buildup is typical and can be wiped down with a lint free cloth and DI water to dissolve the salt deposits as 

needed.
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Chapter 8: Troubleshooting
Occasionally, you may encounter problems while obtaining staining results or performing associated procedures. This chapter describes 

the most commonly reported issues, and identifies the possible causes and solutions. If a problem persists, contact Technical Support 

immediately at 1-800-799-9499 Option 3. Provide details, such as the number of occurrences and associated conditions, and the 

condition and appearance of the slides. 

Printer Port Connections

If slide or reagent labels are not printing, check for the following:

• Power cables are plugged into the printers and VALENT Cart

• USB cables are plugged into the printers and VALENT Cart

• Printers are switched on

If printers are connected properly and powered on, and still no labels are print, log into the VALENT software and go to Tools-> Label 

Designers-> Slide Label Designer.

• Select the drop-down menu next to Slide Printer.

• Choose one of the options in the list.

• Select Test Print. Repeat the last 2 steps until a slide label successfully prints.

• Select the Save & Close button.

• Repeat the same steps for the Reagent Label Designer.

Important Note: There should only be TSC TC310 and TSC TC310 (Copy 1), but if the printers lose connection to a port, the computer 
might create a new port pathway. Therefore, there may be TSC TC310 (Copy 2), TSC TC310 (Copy 3), and so on in the drop down menu).

Changing Printer Labels and Ribbons
 

The reagent and slide label printers, TSC TC310 Thermal Transfer Printers, are manufactured by TSC. Please refer to TSC’s website for 

instructions on how to change printer labels and ribbons at  www.tscprinters.com.
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Staining Performance
Optimal staining results depend on the quality of tissue and the way in which it is processed prior to staining.

Problem Possible Causes & Solutions

No staining, weak or inconsistent 
staining, false negatives.

Cause: Programming errors.

Solution: Review programming and correct errors.

Cause: Slides positioned incorrectly in slide racks. Instruments and slides must be 

horizontal, verified by level gauge. 

Resolution: Reposition slides.

Cause: Slide labels positioned incorrectly onto the slide. If the slide label is not properly 

placed and sticks up even slightly, liquid flow will be impeded and reagents will wick 

and yield poor staining quality. Please see the diagram in the Slide Preparation section 

of chapter 5.

Resolution: Reposition slide labels.

Slides have dried out.

Cause: Slides positioned incorrectly on the VALENT

Resolution: Visually inspect the slides from the front of the instrument, making sure 

they are positioned correctly.

Cause: Prolonged incubation requires continued dispensing of reagent on each slide.

Resolution: For incubation time exceeding one hour, divide protocol step into two, 

consecutive steps with the same reagent.

Tissue lifting off slide.

Cause: Tissue section has not properly adhered.

Resolution: Ensure that positively charged slides are used on the VALENT and FFPE 

tissue samples are adequately dried in the oven before loading onto the instrument.

Need access to a previous run log to 
help determine root cause of weak 
staining or failed run.

Cause: The VALENT Software only displays a run log for the most current run, access to 

previous run is not available in the VALENT Software.

Resolution: Call Technical Support.
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Mechanical

Problem Possible Causes & Solutions

DePar not dispensing correctly.

Cause: DePar container may be empty.

Resolution: Check the DePar container on the left side of the instrument and confirm 

that there is sufficient DePar reagent.  Under Tools-> Instrument Operations -> Drain 

Waste & Prime Buffers, prime DePar until a steady stream is flowing through the DePar 

probe into the Wash Station.   If DePar is still not flowing correctly after priming 3 times, 

call Technical Support.   

AR/DePar not flowing correctly.

Cause: Ports in the manifold are obstructed.

Resolution: Under Tools-> Instrument Operations -> Drain Waste & Prime Buffers to 

prime manifold with Aqua Rinse for 10 seconds, repeat as necessary. If AR is still not 

flowing correctly, does not clear after priming 3 times, call Technical Support.

Probe or wash-blow head misaligned.
Cause: VALENT is out of calibration. 

Resolution: Call Technical Support to calibrate the instrument.

Map of slide layout disappears once 
the corresponding slide tray is removed 
from the VALENT.

Cause: When a user is manually mapping slides, if the user removes the slide tray from 

the VALENT, that particular slide tray will disappear from the Home Screen not allowing 

the user to map slides. The slide tray needs to be loaded into the VALENT to allow slides 

to be manually mapped in the software.

Resolution: Place slide tray back into the VALENT to allow manually mapping and wait 

30 seconds for the Home Screen to reflect that the slide try has been replaced. Once 

slides have been manually mapped, a Slide Layout Report should be printed so the user 

does not lose track of where slides are located.

The reagent rack, slide tray, or system 
lid does not physically unlock.

Cause: Mechanical issue.

Resolution: Call Technical Support. DO NOT ATTEMPT TO UNLOCK WITHOUT BIOCARE 

PERSONNEL ASSISTANCE.
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Electrical

Problem Possible Causes & Solutions

Reagent label printer, slide label printer 
or report printers are not working.

Cause: Printers are not connected to correct port.

Resolution: Check the printer ports to make sure the each printer connection is properly 

connected to the correct port. 

Cause: Printers are not communicating with instrument.

Resolution: Re-start your instrument and computer by following directions on how to 

Safely Turn Instrument On/Off found and Printer Port Connection section in this chapter. 

If problems still persist, contact Technical Support for further assistance. 

Power outage.

Cause: Power outages may cause the instrument to unexpectedly shut down. If the 

instrument is not properly shut down system failure can occur.

Resolution: Re-start your instrument by following directions on how to Safely Turn 

Instrument On/Off found in this chapter. If problems still persist, contact Technical 

Support for further assistance.

Operating Errors

Problem Possible Causes & Solutions

Carboy Details window shows required 
volume from the previous run after a 
run is complete.

Cause: If a user hovers over the carboys from the Home Screen, the required volume from 

the previous run will be displayed. Required volume is not reset once a run is complete.

Resolution: This does not affect a future run. Once the user starts a new run, carboy 

details show required volume correctly.  

The VALENT is in demo mode.
Cause: The instrument and software are not connected.

Resolution: Be sure to turn on the instrument before logging into the VALENT Software.

The software will not allow you to map a 
slide to a particular slide tray.

Cause: There are run requirements that limit what protocol can be processed in the 

same slide tray. Please see Chapter 5 of the Slide Tray section for more information.

Resolution: Move the slide that has a different set of AR or DePar conditions and add to 

another slide tray. 
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An error message appears when editing 
protocols.

Cause: Biocare Medical Protocols cannot be edited, doing so will cause the message 

below to appear.

Resolution: The user can copy and rename a selected Biocare Medical protocol to make 

edits, refer to the Protocol Manager section in Chapter 5.

New reagents can’t be scanned into 
Inventory Manager.

Cause: New reagents can only be scanned into inventory when the user initially logs into 

the system. For example, if a protocol has been run or system cleaning executed, the 

user won’t be able to scan reagents into inventory.

Resolution: To scan reagents into inventory, exit the system and log in again. There is 

also an option of manually entering reagents into inventory.

The barcode camera is not detecting 
slide labels or reagent labels

Cause: Slide labels or reagent labels are positioned incorrectly onto the slide. 

Please see the diagram in the Slide Preparation section of chapter 5.

Resolution: Reposition slide label or reagent label.

Cause: This may be caused by splashes of reagents or residual oil from the 

user’s fingerprints during preparation inhibiting the barcode camera.

Resolution: Use a paper towel to gently wipe the slide 

label or reagent label to remove residual oil.

Reagent level scan is not working 
properly.

Cause: The reagent vial is obstructed.

Resolution: Reposition the vial so that it sits flush in the 

reagent rack. Make sure the cap is removed.

Cause: The liquid level sensor is obstructed with debris.

Resolution: Gently wipe any debris from the liquid level 

sensor with a 70% Isopropyl alcohol lint free wipe.
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Notification that instrument is not 
level.

Cause: The instrument is out of level and needs to be re-leveled.

Resolution: Call Technical Support for instructions on how to re-level the VALENT.

Slide tray cancellations.

Cause: Trough not filling for AR step.

Resolution: Check carboy tubing connections. Use the Drain Waste & Prime buffers tool 

to confirm proper connection (even flow of solution with minimal bubbles in the line). If 

all tubing is connected properly and solution is not flowing as expected, call Technical 

support.

Cause: Temperature did not reach set point.

Resolution: Call Technical Support.
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Appendix- Quick Start Guides
Quick Start Guide 1-Instrument Preparation

Instrument Preparation

1. Turn the VALENT on using the main power switch (white switch) found in the electrical panel of the instrument, on the right side.

2. Turn on the computer and open the VALENT application.

3. Double check that both waste carboys are empty and properly connected to the VALENT.

4. Double check that bulk reagent carboys are filled appropriately and properly connected to the VALENT.

5. Priming the instrument should be done before every run without slide trays. The user should prime until there are no remaining 

bubbles in the carboy tubing or probe coil. When priming the dispense manifold, prime until the stream coming from the port is 

steady and even across the 12 ports. 

6. Priming should also be done when refilling the carboys, priming the manifold is not required for this.

7. Rinse the slide racks with DI water, and carefully brush away any residual deposits of dried buffer that may be present. This will 

prevent contamination from previous runs.

8. Using both hands, one hand holding reagent rack from front and the other hand from the bottom, load the reagent rack with filled 

reagent vials in the correct orientation; the reagent rack handle should be towards the front of instrument, facing the user. Reagent  

vials must be positioned toward the front of the VALENT, facing the user.

9. To print slide or reagent vial labels, make sure the slide label printer, reagent label printer and report printer are attached to the 

computer.

10. When placing the slide label on the slide, the whole label should be completely flattened and adhered to the slide especially the 

bottom of the slide label. A slide label that is not completely flat and sticks up even slightly will cause liquid flow to be interrupted. 

When current flow is affected, reagents will wick and may yield poor staining quality.

11. All slides require a label. If manually mapping, use a VALENT slide label. Failing to use a slide label may yield poor staining quality.

12. Confirm that all slides are inserted all the way under the slide clips, placed securely in the slide clips, and centered. It is important 

that slide labels are viewable by the barcode camera.

Important Note: Be sure to turn on the instrument before logging into the VALENT Software.
Otherwise, the VALENT Software will automatically be opened in demo mode and the run will not start.
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Quick Start Guide 2-Creating a Protocol

1. Log in to the VALENT Software.  

2. Find Data Manager from the menu bar and Click Reagent Manager.

3. Select which reagent group the new reagent is classified under and click .

4. Add the reagent information and click   to Save and click   Close.

5. From the menu bar select Data Manager and then Protocol Manager.

6. To create a new protocol click   and select New Protocol to create from “de novo”, Create from Template or Create from a Selected 
Protocol.

7. Name the Protocol.

8. Use the buttons   to Add, Insert, Delete or Move steps within a protocol.

9. Click Save & Close.
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Quick Start Guide 3-Preparing Slides

1. Log in to the VALENT Software.  

2. Click Prepare Slides. 

3. In the Add Slides window enter Slide Details.

4. Highlight the required protocol and click the green Right Arrow. Repeat until all required protocols have been selected.

5. If positive and negative controls are needed, highlight the boxes next to each protocol that require positive and negative controls.

6. Click OK.

7. In the Slide Manager window, ensure all information is correct including Slide Details and Protocol.

8. Add, Delete or Copy Slides as needed by selecting the appropriate button.

9. Make sure all slides are checked and then click Print Slide Labels .

10. To print reagent labels, click Show Reagent Worksheet .

11. Click Save & Close.

12. Affix labels to reagent vials and slides, making sure slide labels are flat and completely adhere to slide.

13.  Load slides and reagents onto the instrument. 

14. In the Assign Slides window click Scan Mode and select all slide trays that apply.

15. Click Scan Slides.

16. After slides have been scanned, click Prepare Reagents.

17. Click Scan to scan reagents and then Levels to detect reagent levels.

18. Check Bulk and Waste Carboys and Prime Buffers if needed.

19. Click Start Run or (Delayed Run can also be selected).
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Quick Start Guide 4-Process Overview

There are two ways to process slides described below.

Process Overview 1
Summary of the run setup process by Scanning Slide Labels. Details of each step are provided within in Chapter 6.

1. Login 2. Select 
Prepare Slides

3. Print Labels 4. Scan Slides

8. Start Staining5. Prepare & Load 
Reagents

6. Scan or Map 
Reagents

7. Pre-Start 
Checklist

Process Overview 2
Summary of the run setup process using Manual Mapping of Slides. Details of each step are provided in Chapter 6.

1. Login 2. Select 
Map Slides

3. Manually Assign 
Slides

4. Load VALENT 
Labeled Slides

8. Start Staining5. Prepare & Load 
Reagents

6. Scan or Map 
Reagents

7. Pre-Start 
Checklist
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Appendix- Electrical Labels
Electrical Label for the VALENT Cart

 

TO INSTRUMENT

CART BATTERY

Turn cart battery OFF

when cart power is off or 

cart is unplugged.

CART POWER

COMPUTER

INSTRUMENT
POWER

Power: 1,800 VA
115 VAC  100/120 VAC
Model VLT8102: 50 Hz
Model VLT8103: 60 Hz
Circuit Breaker: ISA Resettable

WARNING

Electrical Label for the VALENT 
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800.799.9499

60 Berry Drive

Pacheco, CA 94553 www.biocare.net

VLT8118
112219


